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Preface 

In recent decades, remote sensing and Geographic Information System (GIS) technology have 

been successfully used in a wide range of applications thanks to important advances in the 

integration of remote imagery, computer processing, and spatial analysis technologies. This 

manuscript provides a general introduction to remote sensing imagery and the capabilities of 

GIS technology for data analysis. The goal is to show the potential of an integration of these 

tools and technologies in the field of spatial data modeling, such as resource management and 

environmental monitoring. 

This manuscript is divided into five distinct chapters, namely: 

o Chapter I provides an introduction to the fundamental concepts of remote sensing 

data acquisition. It also explores different types of platforms and sensors and their 

resulting remote sensing applications. 

o Chapter II considers the properties and characteristics of digital remotely sensed 

imagery. It describes some image fusion techniques that assist 

satellite image interpretation. 

o Chapter III looks at the various image processing techniques that are commonly used 

for remote sensing image analysis and interpretation, including preprocessing, 

transformation, and correction methods. 

o Chapter IV provides a general introduction to Geographic Information System (GIS) 

including basic concepts and examples of its applications. 

o Chapter V provides a step-by-step guide to the most important GIS software 

« ArcGIS » with their technical characteristics. 
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I.1 What is remoe sensing ? 

Remote sensing is the process of detecting and monitoring the physical characteristics of an 

area by measuring its reflected and emitted radiation at a distance using instruments which are 

remote to the earth's surface, usually from aircraft or satellites. 

I.2 Remote Sensing Process  

 

Figure. I.1. Remote Sensing Process.  

[https://www.researchgate.net/figure/Remote-Sensing-Process_fig2_328233099] 

a. Energy Source or Illumination  

The energy source illuminates or provides electromagnetic energy to the target of interest.  

b. Radiation and the Atmosphere  

As the energy travels from its source to the target, it will come in contact with and interact 

with the atmosphere it passes through.  

  

c. Interaction with the Target 

Once the energy reached the target through the atmosphere, it interacts with the target 

depending on the properties of both the target and the radiation. 

d. Recording of Energy by the Sensor   

After the energy has been scattered by, or emitted from the target, a remote sensor collects 

and record at distance the electromagnetic radiation. 

e. Transmission, Reception, and Processing  
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The energy recorded by the sensor has to be transmitted, often in electronic form, to a 

receiving and processing station where the data are processed into an image. 

f. Interpretation and Analysis  

The processed image is analysed and interpreted to extract information about the target 

which was illuminated. 

I.3 Electromagnetic Spectrum 

Light emitted by the sun is composed of several different wavelengths, and the full range of 

wavelengths is called the electromagnetic spectrum. The electromagnetic spectrum ranges 

from the shorter wavelengths (including gamma and x-rays) to the longer wavelengths 

(including microwaves and broadcast radio waves) (see Figure. I.2.). There are several 

regions of the electromagnetic spectrum which are useful for remote sensing including : 

 The visible spectrum ; 

 The infrared (IR) region ;  

 The microwave region.  

 

Figure. I.2. Electomagnitic Spectrum.  

[https://www.science-sparks.com/what-is-the-electromagnetic-spectrum/] 

I.3.1 The visible spectrum  

The light which our eyes can detect is part of the visible spectrum. The visible wavelengths 

cover a range from approximately 0.4 to 0.7 mm (see Figure. I.3.). The longest visible 

wavelength is red and the shortest is violet. The visible portion is small relative to the rest of 

the spectrum.  

 

Figure. I.3. The visible spectrum.  

[https://www.univie.ac.at/geographie/fachdidaktik/FD/site/external_htmls/imagers.gsfc.nasa.gov/ems/visible.html] 
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Common wavelengths of from the visible portion of the spectrum are listed below.  

 

 

 

 

 

I.3.2 The infrared (IR) region   

The infrared (IR) region covers the wavelength range from approximately 0.7 mm to 100 mm 

(see Figure. I.4.). It is more than 100 times as wide as the visible portion. 

 

Figure. I.4. The infrared (IR) region spectrum.  

[https://www.thermo-r.com/introduction-to-infrared-radiation/] 

The infrared region can be divided into two categories based on their radiation properties : 

a. The reflected IR 

Covers wavelengths from approximately 0.7 mm to 3.0 mm.  

b. The thermal IR 

This energy is essentially the radiation that is emitted from the Earth's surface in the form of 

heat. The thermal IR covers wavelengths from approximately 3.0 mm to 100 mm. 

I.3.3 The microwave region  

The portion of the spectrum of more recent interest to remote sensing is the microwave 

region from about 1 mm to 1 m (see Figure. I.5.). This covers the longest wavelengths used 

for remote sensing.  



Chapter I.                                                                                                                       Remote Sensing 

12 
 

 

Figure. I.5. The microwave region spectrum.  

[https://www.thermo-r.com/introduction-to-infrared-radiation/] 

The radiation in the visible and near visible regions of the spectrum are the most frequently 

used data sources in natural resources assessment applications of remote sensing  

I.4 Electromagnetic Interactions  

There are two fundamental interactions of the incident electromagnetic energy from the sun 

(see Figure. I.6.):  

 Interactions with the Atmosphere ; 

 Interactions with the target. 

 

Figure. I.6. The electromagnetic interactions. 

[https://www.researchgate.net/figure/Schematic-diagram-of-the-interaction-between-the-main-optically-active-substances-in-

the_fig4_358017599] 

I.4.1 Interactions with the Atmosphere  

The atmosphere influences the incoming radiation by different forms (see Figure. I.7.). 

Natural materials that are present in the atmosphere, e.g., particles, liquid water and 

atmospheric gasses, affect the incoming light energy and radiation by two principal 

mechanisms : scattering and absorption.  
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Figure. I.7. Interactions with the atmosphere. 

[https://atmos.eoc.dlr.de/projects/scops/sciamachy_book/sciamachy_book_figures_springer/chapter_7_figures_springer.html] 

I.4.1.1 Scattering  

Scattering is a process of diffusion, caused by redirecting of the radiation by large gas 

molecules in the atmosphere. There are three different types of scattering which take place 

depends on the wavelength of the radiation, the abundance of particles or gases, and the 

distance the radiation travels through the atmosphere (see Figure. I.7.) : 

 Rayleigh scattering. 

 Mie scattering. 

 Nonselective scattering. 

 

a. Rayleigh scattering   

Rayleigh scattering is the dominant scattering mechanism in the upper atmosphere. It takes 

place when particles are very small compared to the wavelength of the radiation. Therefor, 

rayleigh scattering causes shorter wavelengths of energy to be scattered much more than 

longer wavelengths. Thus, as sunlight passes through the atmosphere, the shorter wavelengths 

(i.e. blue) of the visible spectrum are scattered more than the other (longer) visible 

wavelengths.  

b. Mie scattering  

Mie scattering takes place mostly in the lower portions of the atmosphere wher concentrations 

of larger particles increase, and dominates when cloud conditions are overcast. These particles 

are just about the same size as the wavelength of the radiation. Dust, pollen, smoke and water 

vapour are common causes of Mie scattering which tends to diffuse longer wavelengths than 

those affected by Rayleigh scattering.  
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c. Nonselective scattering   

Nonselective scattering occurs when the particles are much larger than the wavelength of the 

radiation. This type of scattering result where water droplets and large dust particles are 

present. All wavelengths, from visible light up to the reflected infrared portion of the 

spectrum, are scattered about equally. 

I.4.1.2 Absorption  

The second type of interaction with atmosphere is absorption. This phenomenon causes 

molecules in the atmosphere to absorb energy at various wavelengths (see Figure. I.7.). 

Water vapour, carbon dioxide and ozone, are the most important absorbers of the incoming 

solar radiation in atmosphere. The absorption causes a loss of energy, diminishing the energy 

arriving at the surface of the earth. 

I.4.2 Interactions with the Target  

Radiation that is not absorbed or scattered in the atmosphere can reach and interact with the 

Earth's surface. The most common forms of remote sensing are based on reflected 

electromagnetic energy (see Figure. I.8.). Different materials reflect different amounts of 

incoming energy, and this differential reflectance gives objects a distinct appearance. We use 

these differences to distinguish among objects. 

 

Figure. I.8. The Interactions with the Target.  

[https://www2.geog.soton.ac.uk/users/trevesr/obs/rseo/energy_interactions_with_the_earths_surface.html] 

Depends on the characteristics of the surface features and the wavelength of the incident 

radiation, three forms of interaction can take place when the incident energy reachs the 

surface:  

 Absorption;  

 Transmission;  

 Reflection.  

I.4.2.1 Absorption  

Absorption occurs when radiation (energy) is absorbed into the target. 

I.4.2.2 Transmission  

Transmission occurs when radiation passes through a target.  



Chapter I.                                                                                                                       Remote Sensing 

15 
 

I.4.2.3 Reflection 

Reflection occurs when radiation reflect the target and is redirected. Measuring the radiation 

reflected from targets represent the most important objectif of remote sensing. We refer to two 

types of reflection in which energy is reflected from a target (see Figure. I.9.) :  

 Specular reflection ;  

 Diffuse reflection. 

 

Figure. I.9. Specular and diffuse reflection. 

[https://www2.geog.soton.ac.uk/users/trevesr/obs/rseo/energy_interactions_with_the_earths_surface.html] 

a. Specular or mirror-like reflection  

Specular or mirror-like reflection takes place when a target surface is smooth. In this case, 

main part of the energy is directed away from the surface in a single direction.  

b. Diffuse reflection   

Diffuse reflection takes place when the target surface is coarse and the energy is reflected 

almost uniformly in all directions.  

I.5 Spectral response (Spectral Signatures)   

Depending on the composition complexity level of the target that is being observed at, and the 

wavelengths of radiation involved, we can distinguish very different responses to the 

mechanisms of absorption, transmission, and reflection. The spectral response for this object 

can be obtained by measuring the energy that is reflected (or emitted) by targets on the Earth's 

surface over a variety of different wavelengths.  

The comparison of the response patterns corresponding to different features, allows to 

distinguish between them, where it is not the case, if we only compared them using only on 

one wavelength. For example, if we consider water and vegetation, their spectral responses 

are similars in the visible wavelengths but are almost always separable in the infrared.  

It should be noted that the spectral response can be quite variable, even for the same target 

type, and can also vary with time and location.  
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Figure. I.10. Spectral response. 
[https://www2.geog.soton.ac.uk/users/trevesr/obs/rseo/energy_interactions_with_the_earths_surface.html] 

I.5.1 Examples of interaction with target (Spectral response)  

In environmental mapping applications, the basic objects under investigation are often 

vegetation (species, cover, status, etc.), soils and geology (type of geological structure, soil 

type, etc.) and water (availability, quality, etc.). Knowing the basic principles of how these 

reflect in different wavelength bands will help an interpreter in the mapping work. Figure. 

I.10. shows the spectral reflectance curve for green vegetation, soil and water. 

I.5.1.1 Vegetation  

Healthy vegetation absorbs blue and red wavelengths but reflects green and infrared. 

Vegetation has a small peak in reflection in the green band making it appear green to the 

human eye, but as seen, the maximum reflectance of vegetation is in the NIR band, in the 13 

range 0.7 to 1.4 m. Since we can't see infrared radiation, we see healthy vegetation as green. 

I.5.1.2 Water  

Water absorbes longer visible wavelengths (green and red) and near-IR radiation more than 

shorter visible wavelengths (blue). Thus, Water usually looks blue or blue-green. Reflection is 

highest towards the blue band and into the UV-band. On the other hand, water will appear 

brighter when some sediment are present in the upper layers. To distinguish water bodies 

from other features radiation, the NIR band should be used since water will appear as almost 

black in this range of spectrum.  

I.5.1.3 Soil  

The spectral signature of soil is characterised by a moderate variation over the range of 

wavelengths. Soil reflectance is affected by moisture, texture, and mineral content, colour 

(presence of different oxides, etc.) and the content of organic matter. Dry soils reflect more 

radiation than humid and coarse textured soils more than fine textured under normal humidity 

conditions.  
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I.5.2 Spectral Properties and Principal Applications   

Example in Landsat TM/ETM 

Band Wavelength (m) Principal applications 

B-1 0.45 - 0.52 (Blue)  Mapping coastal water areas.  

 Differentiating between soil and vegetation. 

 Forest type mapping. 

 Detecting cultural features. 

 

B-2 

0.52 - 0.60 (Green)  Corresponds to the green reflectance of healthy 
vegetation.  

 Identification of cultural feature. 

 

 

B-3 

0.63 - 0.69 (Red)  Discriminating between many plant species.  

 Determining soil boundary and geological 
boundary delineations as well as cultural features. 

B-4 0.76 - 0.90 (Near-

Infrared) 
 Responsive to the amount of vegetation biomass 

present in a scene.  

 Identification of crop  and emphasizes soil/crop 
and land/water contrasts. 

B-5 1.55 - 1.75 (Mid-

Infrared ) 
 Sensitive to the amount of water in plants.  

 Study of crop drought. 

 Analysis of plant health.  

 Discriminating between clouds, snow, and ice. 

B-6 10.4 - 12.5 (Thermal 

Infrared) 
 Detection of vegetation and crop stress, heat 

intensity, insecticide applications, and for 

locating thermal pollution.  

 Locate geothermal activity. 

B-7 2.08 - 2.35 (Mid-

Infrared) 
 Discrimination of geologic rock type and soil 

boundaries, as well as soil and vegetation 

moisture content. 

 

Table. I.1. Spectral Properties and Principal Applicationsof Landsat TM/ETM. 

I.6 Remote Sensing Platforms Systems 

Platforms refer to the structures or vehicles on which remote sensing instruments are 

mounted, i.e. satellite, aircraft, balloon, etc....  

There are three broad categories of remote sensing platforms (see Figure. I.11.):  

 Ground based ; 

 Airborne ;  

 Satellite. 
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Figure. I.11. Remote Sensing Platforms. 

[https://www.researchgate.net/figure/Various-platforms-and-sensors-used-for-remote-sensing_fig1_307351403] 

I.6.1 Ground based sensors  

Ground-based instruments are used when the area under study are relatively small. For 

example, to study properties of a single plant or a small patch of grass, it would make sense to 

use a ground based instrument. Common ground based platforms used in remote sensing are 

hand held devices, towers and cranes. 

I.6.2  Airborne  

In the early remote sensing applications, airborne platforms were the main non-ground-based 

platforms for the acquisition of aerial photography. 

I.6.3  Satellite  

Satellites are the most common remote sensing stable spaceborne platforms. The first remote 

sensing satellite was launched in 1960 for meteorology purposes. Remote sensing satellites 

are used for environmental monitoring, meteorology, and cartography. Satellites has the 

advantage of offering very long periods of operation, using repetitive orbits and providing 

global coverage. 

A satellite orbit is the curved path that a satellite in space takes around the earth due to gravity 

(see Figure. I.12.). A satellite follows a generally elliptical orbit around the earth.  
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Figure. I.12. Satellite Orbit. 

[https://www.nrcan.gc.ca/maps-tools-and-publications/satellite-imagery-and-air-photos/tutorial-fundamentals-remote-

sensing/satellites-and-sensors/satellite-characteristics-orbits-and-swaths/9283] 

A satellite orbit is characterized by : 

 The orbital period : is the time taken by the satellite to complete one revolution of 

the orbit. 

 The repeat cycle of the satellite : refers to the time interval at which the satellite 

repeats its path. 

 Altitude : is the satellite's distance from the Earth’s surface. Common remote sensing 

satellites typically maintain higher orbits ranging from 600 to 1000 km. 

These satellite orbital characteristics determine the frequency at which a satellite sensor can 

acquire data. For most remote sensing satellites the total coverage frequency ranges from 

twice a day to once every 16 days. 

Satellites can be classified by their orbital geometry characteristics and timing. There are two 

principal types of satellite orbit: 

 Geostationary ; 

 Sun Synchronous. 

I.6.3.1 Geostationary Orbits  

The satellite appears stationary with respect to the Earth's surface (see Figure. I.13.). 

Satellites in the geostationary orbits are located at a very high altitude of 36,000 km. This 

enable to the satellite to cover the same large area on the earth at all times. Especially, the 

geostationary orbits are commonly used by meteorological satellites. 

 

Figure. I.13. Geostationary satellite orbit. 

[https://electronicsdesk.com/geostationary-orbit.html] 

 

https://crisp.nus.edu.sg/~research/tutorial/meteo.htm
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Advantages of geostationary orbits are : 

 Fixed position on specific location  

 Same speed as earth rotation speed  

 Wide area coverage  

 Especially designed for weather monitoring 

However, disadvantages include the typically low spatial resolution which results from high 

altitude. 

I.6.3.2 Sun Synchronous Orbits  

The satellite with a sun-synchronous orbit always passes over a location at a given latitude at 

the same local solartime. (see Figure. I.14.). Thus, the image acquisition process occurs in the 

same solarillumination condition. Most of the earth resources satellites are sun-synchronous 

orbit. 

 

Figure. I.14. Sunsynchronous satellite orbit. 

[https://fr.wikipedia.org/wiki/Orbite_h%C3%A9liosynchrone] 

Examples : 

Landsat TM/ETM, SPOT, ALOS, IKONOS, QuickBird. 

I.7 Remote Sensing Sensors  

Sensors are devices that receive and measure radiation over a range of electromagnetic 

spectrum wavelengths, called bands, which corresponds to the brightness in a given direction 

toward the sensor. The measures are quantized and converted into a signal that can be 

recorded as digital image. Sensors can be on board of airplanes or on board of satellites. One 

platform can carry more than one sensor.  

Examples : 

Platform Name Sensor Name 

Landsat TM Thematic Mapper 

Landsat ETM Enhanced Thematic Mapper 

ALOS PRISIM 

AVNIR-2 

PALSAR 

 

FigureTable. I.2. Example of Remote sensing Platforms. 
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I.7.1 Types of Remote Sensing sonsor 

There are two types of remote sensing sonsors (see Figure. I.15.) : 

 Passive Remote Sensing 

 Active Remote Sensing. 

 

 

Figure. I.15. Types of Remote Sensing. 

 [https://fr.wikipedia.org/wiki/Orbite_h%C3%A9liosynchrone] 

 

I.7.1.1 Passive Remote Sensing  

Remote sensing systems which use energy generated by the sun are called passive sensors. 

Only the surface reflected energy provides information on the features of interest. Most aerial 

images and satellite data are collected using passive systems. Such systems are not useful 

during cloudy or extremely hazy periods because nearly all the energy is scattered and no 

directly reflected energy may reach the sensor.  

a. Advantages 

 Generally simpler in design (built only to receive energy) ; 

 Provide very useful information for monitoring plant and canopy properties. 

 

b. Disadvantages  

 Require sunlight in order for useful data to be acquired.  

 Data acquisition is very dependent on lighting (time of day, time of year, latitude) and 

weather conditions. 

 Interference problems with environment (the signals can be greatly altered due to 

atmospheric effects) 

I.7.1.2 Active Remote Sensing  

Active remote sensing system provide their own source of electromagnetic radiation to 

illuminate the target under investigation. The sonsor detects and measures the radiation 

reflected from that target.  

Examples :  

Radar (radio detection and ranging) is the most common active remote sensing system, while 

the use of LiDAR systems (light detection and ranging), is increasing. Because a given radar 
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system is typically restricted to one wavelength, radar images are usually monochromatic (in 

shades of gray).  

a. Advantages  

 These images may be collected day or night ; 

 Most radar systems penetrate clouds because water vapor does not absorb the 

relatively long radar wavelengths. 

 Do not require solar illumination of surfaces or perfect weather conditions to collect 

useful data.  

 Can be deployed in conditions of haze, clouds, or light rain (depending on the 

wavelength of the system). 

 The ability to obtain measurements anytime, regardless of the time of day or season.  

 Can be used for examining wavelengths that are not sufficiently provided by the sun, 

such as microwaves, or to better control the way a target is illuminated.  

 

b. Disadvantages  

 Active systems require the generation of a fairly large amount of energy to adequately 

illuminate targets. 

I.8 Satellite resolution 

The platform on which a particular sensor is carried determines a number of attributes, which 

may dictate the use of particular sensors. These attributes include: distance the sensor is from 

the object of interest, periodicity of image acquisition, timing of image acquisition, and 

location and extent of coverage. Therefore, the resulting images have different characteristics 

(resolutions) depending on the sensor. Each of these satellite-sensor platform is characterised 

by :  

 Spectral resolution ;  

 Spatial resolution ; 

 The coverage area and the temporal coverge.   

I.8.1 Spectral resolution  

The spectral resolution is the number and location in the electromagnetic spectrum of the 

spectral bands employed in image acquisition, for each band corresponds an image (see 

Figure. I.16.).  

 

Figure. I.16. Spectral resolution. 

 [https://www.onestopgis.com/Aerial-Photography/Digital-Imaging/Digital-Image/2-Sensor-Resolutions-Radiometric-Spatial-

Spectral-and-Temporal.html] 
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Therefore, the satellite imaging systems can be classified into: 

 Optical imaging systems (include visible, near infrared, and shortwave infrared 

systems) 

 Thermal imaging systems 

 Synthetic aperture radar (SAR) imaging systems. 

I.8.1.1 Optical/thermal imaging systems  

Can be classified according to the number of spectral bands used: 

 Monospectral or panchromatic (single wavelength band, "black-and-white", grey-scale 

image) systems 

 Multispectral (several spectral bands) systems 

 Hyperspectral (hundreds of spectral bands) systems 

I.8.1.2 Synthetic aperture radar imaging systems  

Radiometric resolution, usually measured in bits (binary digits), is the range of available 

brightness values, which in the image correspond to the maximum range of DNs.  

Example : 

An image with 8 bit resolution has 256 levels of brightness. 

Therefore, the imaging systems can be classified into according to the frequency bands, e.g.: 

 Single frequency (L-band, or C-band, or X-band) 

 Multiple frequency (Combination of two or more frequency bands) 

I.8.2 Spatial resolution   

Spatial resolution is a measure of the smallest object, i.e., the size of the ground area, usually 

measured in pixel size, that can be covered by the sensor. 

 

Figure. I.17. Spatial resolution. 

 [https://www.onestopgis.com/Aerial-Photography/Digital-Imaging/Digital-Image/2-Sensor-Resolutions-Radiometric-Spatial-

Spectral-and-Temporal.html] 

According to the spatial resolution, the satellite imaging systems can be classified into (see 

Figure. I.17.): 

 Low resolution systems (approx. 1 km or more) 

 Medium resolution systems (approx. 100 m to 1 km) 

 High resolution systems (approx. 5 m to 100 m) 

 Very high resolution systems (approx. 5 m or less) 
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Examples: 

Spatial resolution  Sensor Systems Name 

 

 

Low resolution  

 Geostationary Satellites 

 Polar Orbiting Meteorological Satellites (NOAA-

AVHRR, DMSP-OLS) 

 Orbview2-SeaWiFs 

 SPOT4-Vegetation 

 ADEOS-OCTS 

 

Medium resolution  

 TERRA-MODIS 

 ENVISAT-MERIS 

 ADEOS2-GLI 

 

 

High resolution  

 LANDSAT 

 SPOT 1, 2, 4 

 MOS 

 EO1 

 IRS 

 RESURS 

 

 

Very high 

resolution  

 IKONOS2 

 EROS-A1 

 Quickbird2 

 Orbview3 

 SPOT5 

 

Table. I.3. Remote sensing satellite sensors resolutions. 

I.8.3 The coverage area and the temporal coverge   

The coverage area reffers to how frequent a given location on the earth surface can be imaged 

by the imaging system (see Figure. I.18.). On th eother hand, the temporal coverage for 

satellites sensors, called the temporal resolution, refers to the time required for revisiting the 

same area of the Earth. 

 

Figure. I.18. Temporal resolution (orbital period). 

 [https://www.onestopgis.com/Aerial-Photography/Digital-Imaging/Digital-Image/2-Sensor-Resolutions-Radiometric-Spatial-

Spectral-and-Temporal.html] 
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I.9 Examples of Remote sensing satellites  

I.9.1 Landsat Satellite  

Landsat is a set of multispectral satellites developed by the NASA (National Aeronautics and 

Space Administration of USA), since the early 1970’s (see Figure. I.19.). Landsat images are 

commonly used for environmental research. The resolutions of Landsat 4 and Landsat 5 

sensors are reported in the following table. Landsat temporal resolution is 16 days. 

 

Figure. I.19. LANDSAT 5 satellite. 

 [https://eo.belspo.be/en/satellites-and-sensors/landsat-5] 

Landsat 4, Landsat 5 Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1 - Blue 0.45 - 0.52 30 

Band 2 - Green 0.52 - 0.60 30 

Band 3 - Red 0.63 - 0.69 30 

Band 4 - Near Infrared (NIR) 0.76 - 0.90 30 

Band 5 - SWIR 1.55 - 1.75 30 

Band 6 - Thermal Infrared 10.40 - 12.50 120 (resampled to 30) 

Band 7 - SWIR 2.08 - 2.35 30 

 

Table. I.4. Landsat 4 and Landsat 5 satellite sensors characteristics. 

https://semiautomaticclassificationmanual-v5.readthedocs.io/fr/latest/remote_sensing.html#id33
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Landsat 7 Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1 - Blue 0.45 - 0.52 30 

Band 2 - Green 0.52 - 0.60 30 

Band 3 - Red 0.63 - 0.69 30 

Band 4 - Near Infrared (NIR) 0.77 - 0.90 30 

Band 5 - SWIR 1.57 - 1.75 30 

Band 6 - Thermal Infrared 10.40 - 12.50 60 (resampled to 30) 

Band 7 - SWIR 2.09 - 2.35 30 

Band 8 - Panchromatic 0.52 - 0.90 15 

 

Table. I.5. Landsat 7 satellite sensor characteristics. 

Landsat 8 Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1 - Coastal aerosol 0.43 - 0.45 30 

Band 2 - Blue 0.45 - 0.51 30 

Band 3 - Green 0.53 - 0.59 30 

Band 4 - Red 0.64 - 0.67 30 

Band 5 - Near Infrared (NIR) 0.85 - 0.88 30 

Band 6 - SWIR 1 1.57 - 1.65 30 

Band 7 - SWIR 2 2.11 - 2.29 30 

Band 8 - Panchromatic 0.50 - 0.68 15 

Band 9 - Cirrus 1.36 - 1.38 30 

Band 10 - Thermal Infrared (TIRS) 1 10.60 - 11.19 100 (resampled to 30) 

Band 11 - Thermal Infrared (TIRS) 2 11.50 - 12.51 100 (resampled to 30) 

 

Table. I.6. Landsat 8 satellite sensor characteristics. 
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I.9.2 Sentinel-2 Satellite 

Sentinel-2 is a multispectral satellite developed by the European Space Agency (ESA) in the 

frame of Copernicus land monitoring services (see Figure. I.20.). Sentinel-2 acquires 13 

spectral bands as illustrated in the following table. 

 

Figure. I.20. Sentinel-2 satellite. 

 [https://www.researchgate.net/figure/Sentinel-2-satellite-3_fig1_334432047] 

Sentinel-2 Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1 - Coastal aerosol 0.443 60 

Band 2 - Blue 0.490 10 

Band 3 - Green 0.560 10 

Band 4 - Red 0.665 10 

Band 5 - Vegetation Red Edge 0.705 20 

Band 6 - Vegetation Red Edge 0.740 20 

Band 7 - Vegetation Red Edge 0.783 20 

Band 8 - Near Infrared (NIR) 0.842 10 

Band 8A - Vegetation Red Edge 0.865 20 

Band 9 - Water vapour 0.945 60 

Band 10 - SWIR - Cirrus 1.375 60 

Band 11 - SWIR 1.610 20 

Band 12 - SWIR 2.190 20 

 

Table. I.7. Sentinel-2 satellite sensor characteristics. 

 

https://semiautomaticclassificationmanual-v5.readthedocs.io/fr/latest/remote_sensing.html#id34
http://copernicus.eu/
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I.9.3 ASTER Satellite 

The ASTER (Advanced Spaceborne Thermal Emission and Reflection Radiometer) satellite 

was launched in 1999 by a collaboration between the Japanese Ministry of International Trade 

and Industry (MITI) and the NASA (see Figure. I.21.). ASTER bands are illustrated in the 

following table. 

 

Figure. I.21. ASTER satellite. 

 [https://www.jpl.nasa.gov/missions/advanced-spaceborne-thermal-emission-and-reflection-radiometer-aster] 

ASTER Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1- Green 0.52 - 0.60 15 

Band 2- Red 0.63 - 0.69 15 

Band 3N- Near Infrared (NIR) 0.78 - 0.86 15 

Band 4- SWIR 1 1.60 - 1.70 30 

Band 5- SWIR 2 2.145 - 2.185 30 

Band 6- SWIR 3 2.185 - 2.225 30 

Band 7- SWIR 4 2.235 - 2.285 30 

Band 8 - SWIR 5 2.295 - 2.365 30 

Band 9 - SWIR 6 2.360 - 2.430 30 

Band 10 - TIR 1 8.125 - 8.475 90 

Band 10 - TIR 2 8.475 - 8.825 90 

Band 11 - TIR 3 8.925 - 9.275 90 

Band 12 - TIR 4 10.25 - 10.95 90 

Band 13 - TIR 5 10.95 - 11.65 90 

 

Table. I.8. ASTER satellite sensor characteristics. 

https://semiautomaticclassificationmanual-v5.readthedocs.io/fr/latest/remote_sensing.html#id35
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I.9.4  MODIS Products 

The MODIS (Moderate Resolution Imaging Spectroradiometer) is an instrument operating on 

the Terra and Aqua satellites launched by NASA in 1999 and 2002 respectively (see Figure. 

I.22.). Its temporal resolutions allows for viewing the entire Earth surface every one to two 

days.  

 

Figure. I.22. MODIS satellite. 

 [https://fr.wikipedia.org/wiki/Aqua_(satellite)] 

MODIS Bands Wavelength 

(micrometers) 

Resolutions  

(meters) 

Band 1 - Red 0.62 - 0.67 250 - 500 

Band 2 - Near Infrared (NIR) 0.841 - 0.876 250 - 500 

Band 3 - Blue 0.459 - 0.479 500 

Band 4 - Green 0.545 - 0.565 500 

Band 5 - SWIR 1 1.230 - 1.250 500 

Band 6 - SWIR 2 1.628 - 1.652 500 

Band 7 - SWIR 3 2.105 - 2.155 500 

 

Table. I.9. Remote sensing MODIS satellite sensor characteristics. 

 

 

 

 

https://semiautomaticclassificationmanual-v5.readthedocs.io/fr/latest/remote_sensing.html#id36
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II.1 Remotely sensed image 

A digital remotely sensed image is a two-dimensional array composed of picture elements 

(pixels) arranged in columns and rows. Remote sensing data is converting of spectral 

reflectance value to digital number (DN) known as a pixel arranged in columns and rows (see 

Figure. II.1.).  

 
Figure. II.1. Structure od Remote Sensed Image. 

 [http://sar.kangwon.ac.kr/etc/fundam/chapter1/chapter1_7_e.html] 

Each spectral wavelength represents as a single layer in remote sensing data called “Band” or 

“Channel”. The more bands or channels present, the more spectral properties in remote 

sensing data. 

II.2 Pixels  

Pixels are smallest units of an image. A pixel has an intensity value and a location address in 

the two dimensional image. Associated with each pixel is a number known as Brightness 

Value (BV), that depicts the average radiance of a relatively small area within a scene (see 

Figure. II.1.). A smaller number indicates low average radiance from the area and the high 

number is an indicator of high radiant properties of the area.  

The size of this area effects the reproduction of details within the scene (see Figure. II.2.). As 

pixel size is reduced more scene detail is presented in digital representation. 

 

Figure. II.2. Pixel size and details level on the scene. 

 [https://www.sciencedirect.com/topics/earth-and-planetary-sciences/spatial-resolution] 
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II.3 Characteristics of Remotely sensed images  

Remotely sensed data are images representing a parts of the land surface under study obtained 

at a distance through sensors mounted on aerial or satellite platforms. Remotely sensed 

images are valuable sources of spatial data for many reasons, including: 

 Large-area coverage  

Images capture data from large areas at a relatively low cost and in a uniform manner. 

 Extended spectral range   

Aerial and satellite scanners are sensitive to broader spectral ranges, up to thermal 

wavelengths and beyond. This expanded spectral range allows us to detect features or 

phenomena that appear invisible to the human eye. 

 Geometric accuracy   

Remotely sensed data may be converted to geometrically accurate spatial data. Distortion 

removal methods provide highly accurate spatial data from images. These systems are 

combined with techniques for identifying and removing most of the spatial error in aerial or 

satellite images, so spatially accurate data may be collected from images. 

 Permanent record  

An image is fixed in time, so the conditions at the time of the photograph may be analyzed 

many years hence. Comparison of conditions over multiple dates, or determination of 

conditions at a specific date in the past are often quite valuable, and remotely sensed images 

are often the most accurate source of historical information. 

II.4 Types of Remotely sensed images  

Two types of remote sensing images can be distinguished (see Figure. II.3.):  

 Aerial photography ;  

 Satellite imagery. 

 

Figure. II.3. Aerial and Satellite images. 

 [https://blog.hxgncontent.com/which-imagery-is-better-aerial-or-satellite/] 
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II.4.1 Aerial photography  

Aerial photography is widely used in the early remote sensing applications. Airplanes and 

helicopters are the most platforms for the hardware used to take aerial photographs. Aerial 

photography can be active or passive. Digital aerial cameras normally operate in four wave 

bands, blue, green, red and near infrared. 

It is appropriate to use aerial photography when : 

 The area of interest is small or relatively small,  

 The area of interest is heterogeneous,  

 Objects of interest are tiny or the mapping units small,  

 The objects of interest can easily be identified in the visible wavelengths,  

 When stereo-pairs and 3D interpretation will improve the results. 

 

a. Advantage   

 The interpretation of photographs is quite easy and intuitive, since the objects look 

familiar even to the non-experienced interpreter. 

 

b. Disadvantages  

 Photographic remote sensing systems reproduce an average image of the reflected 

energy from a surface without considering the differences that might occur in 

reflectance in different wavelengths bands. Thus, many objects are impossible to 

separate when studying only the average reflection. 

 A source of potential error in an aerial photograph is relief displacement. This error is 

frequently seen with trees and multistory buildings and worsens with increasingly 

taller features. 

II.4.2 Satellite imagery : 

Satellite images are images of Earth collected by sensors that are mounted satellite orbiting 

the earth. It is appropriate to use satellite imagery when : 

 The area of interest is large ; 

 Repetitive imaging activity survey. 

 

a. Advantages  

 Large area coverage; 

 Frequent and repetitive coverage of an area of interest; 

 Quantitative measurement of ground features using radiometrically calibrated 

sensors; 

 Semiautomated computerised processing and analysis; 

 Relatively lower cost per unit area of coverage. 

 

b. Disadvantage  

https://en.wikipedia.org/wiki/Image
https://en.wikipedia.org/wiki/Earth
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 Satellite imagery are often of a lower spatial resolution compared to aerial 

photography.  

However, very high resolution imagery (up to 1-m resolution) is now commercially available 

to civilian users with the successful launch of the IKONOS-2 satellite. 

II.4.3  Differences between Aerial photography and Remote sensing imagery : 

 Aerial photography Remote sensing imagery 

Distance  Taken from an altitude of a few 
hundred meters to thousand 

meters.  

 Covers a smaller area of a few 
hundred square kilometers.  

 Captured from 600-
1000km. 

 Covers a large area 
ranging from 3500 to 

above 30000 square 

kilometers.  

Types of data  Aircraft are mounted with several 
different cameras or sensors.  

 Capture standard imagery, radar, 
and color infrared images.  

 It is easier to change the sensors, 

thus allowing the aerial acquisition 

to keep ahead of the latest 

advancements in technology. 

 Collect various data, 
including; color 

infrared, thermal, 

radar data, and 

standard 

photographic 

imagery.  

 With technology 
improvements, it is 

challenging to 

change the sensors 

and cameras in a 

satellite. 

Weather 

conditions 

effects 

 Surveys are adversely affected by 
the weather.  

 Surveys are not 
constrained by 

weather.  

 Clouds may conceal 
some information 

available on NIR 

bands. 

Level of detail  Aerial photography snapshots are 
taken by cameras and photographic 

films from an altitude of a few 

thousand meters.  

 The photographs have a very high 
degree of detail. 

 Satellite images are 
taken from a distance 

of about 900km 

above the Earth’s 

surface.  

 The photos are taken 
digitally, which can 

be further improved 

or enhanced.  

 The degree of detail 

is restricted to pixel 

https://crisp.nus.edu.sg/~research/tutorial/ikonos.htm
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resolutions of the 

sensors. 

Speed  Used to be a slow and time-

consuming process.  

 The size and shape of a 
geographical area to be captured 

determined the amount of time 

taken.  

 Using airplanes to fly back and 
forth led to a series of overlapping 

photographs being taken.  

 Collecting large 

amounts of data in a 

relatively limited 

time frame.  

 The sizes of the 
pictures allow a 

complete site to be 

captured in a small 

time frame and using 

fewer images. 

Location  There is delayed surveys and 

image attainment depending on the 

location of the study.  

 The surveying team has to be in 
the study area to ensure a weather 

window is not missed. 

 Satellite imagery of a 

particular location in 

the world can easily 

be obtained once a 

satellite is 

positioned.  

 There is no need to 
cross different 

countries’ borders or 

go through 

government 

protocols that could 

delay the attainment 

of the images. 

Resolution  The high resolution on the ground 

permits the identification and 

mapping of very small objects, and 

gives them an obvious advantage 

over satellite imagery for local 

surveys. 

 

  Collects data over a broad range of 
wavelengths and sensors are 

normally tuned to collect data from 

only a limited wavelength range. 

 

 

Table. II.1. Differences between Aerial photography and Remote sensing imagery.  
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II.5 Resolution and Sampling in Remotely Sensed Data 

The quality and quantity of satellite imagery is largely determined by their resolution. It 

determine the level of details of the modeling process. There are four types of resolution that 

characterize any particular remote sensor :  

 Spectral resolution ;  

 Radiometric resolution ; 

 Spatial resolution ;  

 Temporal resolution. 

 

II.5.1 The spatial resolution  

Spatial resolution refers to the size of the pixels representing the ground coverage in the 

image. If a satellite produces imagery with a 10 m resolution, the corresponding ground 

coverage for each of those pixels is 10 m by 10 m, or 100 square meters on the ground. The 

detail discernible in an image is dependent on the spatial resolution of the sensor (see Figure. 

II.4.).  

Satellite Spatial Resolution 

Landsat 8 30m 

MODIS (Terra + Aqua) 250m, 500m, 1000m 

VIIRS 375m 

AVHRR 1100m 

Sentinel-2 10m, 20m, 60m 

SPOT-7 1.5, 6m 

QuichBird 67cm 

Ikonos 0.8m, 3.2m 

 

Table. II.2. Example of remote sensing satellite sonsor spatial resolutions. 

We distinguished two spatial resolution levels: 

a. High Resolution image (smaller pixels)  

Refers to one with a small resolution size. Fine details can be seen in a high resolution image.  

b. Low Resolution image (large pixels)  

Refers to one with a large resolution size. Only coarse features can be observed in the image. 
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Figure. II.4. Satellite image with differnet Spatial resolutions. 

 [https://www.neonscience.org/resources/learning-hub/tutorials/raster-res-extent-pixels-r] 

II.5.1.1 Spectral resolution : 

The spectral resolution refers to the interval size of the wavelengths and the number of 

intervals being scanned, also called bands. Multispectral and hyperspectral sensors are those 

sensors that can cover a multitude of wavelength intervals within the spectrum. 

 

Satellite Spectral 

Resolution 

Landsat 8 11 bands 

MODIS (Terra + Aqua) 36 bands 

VIIRS 22 bands 

AVHRR 6 bands 

Sentinel-2 12 bands 

SPOT-7 5 bands 

QuichBird 4 bands 

Ikonos 4 bands 

 

Table. II.3. Example of remote sensing satellite sonsor spectral resolutions. 

II.5.1.2 Temporal resolution : 

The temporal resolution refers to the amount of time between each image collection period 

and is determined by the repeat cycle of the satellite’s orbit. It is the length of time it takes for 

a satellite to complete one entire orbit cycle. The more frequently it is captured, the better or 

finer the temporal resolution is said to be.  

We distinghuised three tempotal resolution levels : 

 High temporal resolution: < 24 hours - 3 days  

 Medium temporal resolution: 4 - 16 days  

 Low temporal resolution: > 16 days 
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Satellite Temporal Resolution 

Landsat 8 16 days 

MODIS (Terra + 

Aqua) 

16 days 

VIIRS 1 day 

AVHRR 2 days 

Sentinel-2 5 days 

SPOT-7 26 days 

QuichBird 1-4 days 

Ikonos 3 days 

 

Table. II.4. Example of remote sensing satellite sonsor temporal resolutions. 

II.5.1.3 The radiometric resolution  

The radiometrics resolution refers to the sensitivity of the sensor to variations in brightness. 

Specifically, it denotes the number of grayscale levels that can be imaged by the sensor. The 

finer the radiometric resolution of a sensor, the more sensitive it is to detecting small 

differences in reflected or emitted energy (see Figure. II.5.).  

 

Figure. II.5. Satellite image with differnet Radiometric resolutions. 

 [https://gisgeography.com/bit-depth/] 

Typically, the available radiometric values for a sensor are :  

 8-bit (yielding values that range from 0–255 as 256 unique values or as 28 values);  

 11-bit (0–2,047);  

 12-bit (0–4,095);  

 16-bit (0–63,535).  

Example :  

Landsat-7 and Landsat TM 8 bits maintain 8-bit resolution for its bands and can therefore 

record values for each pixel that range from 0 to 255. 
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II.5.1.4 Choosing Resolution 

There is a trade-off between the different types of resolution. Improving one type of 

resolution often necessitates a reduction in one of the other types of resolution. A high spatial 

resolution tends to be accompanied by a low temporal resolution and vice versa. An increase 

in spatial resolution is typically associated with a decrease in spectral resolution, and vice 

versa. For example, Landsat 8 has a spatial resolution of 30 m and a temporal resolution of 16 

days, while MODIS has a spatial resolution of 250 m to 1 km and a temporal resolution of 1 

to 2 days  

It is important to pick the most useful resolutions for a specific project. High spatial 

resolutions are useful for small study areas or examining an area in fine detail. High temporal 

resolutions are useful in dynamic, frequently changing environments and areas with high 

levels of cloud cover 

II.6 Spectral satellite imaging  

The satellites cover different portions of the electromagnetic spectrum and record the 

incoming radiations at different spectral resolutions. Most of these sensors operate in three 

modes (see Figure. II.6.):  

 Panchromatic mode ; 

 Multispectral mode ; 

 Hyperspectral mode. 

 

Figure. II.6. Multi spectral and panchromatic images.  

 [https://www.researchgate.net/figure/Multispectral-and-Panchromatic-Images-a-MS-Image-of-1st-Set-b-PAN-Image-of-1st-

Set_fig4_330493532] 

II.6.1 The panchromatic mode : 

A panchromatic image corresponds to only one spectral band displayed as a greyscale image, 

representing the brightness intensity of different pixels that compose the image. The 

Radiometric information is the main information type utilized in the interpretation of the 

panchromatic image. 
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II.6.2 The multispectral (color) mode : 

A multi-spectral image is a collection of several monochrome images of the same scene, each 

of them acquired at a particular wavelength measured by a sensor. Each image is referred to 

as a band. Bands represent ranges of the electromagnetic spectrum in cluding the acquisition 

of visible, near infrared, ultra-violet, and short-wave infrared images in several broad 

wavelength bands. Multi-spectral images are most commonly used for remote sensing 

applications such as discrimination of land surface features and landscape patterns. 

Example 

An example of a multispectral sensor is Landsat-8. For example, Landsat-8 produces 11 

images with the following bands: 

 COASTAL AEROSOL in band 1 (0.43-0.45 um) 

 BLUE in band 2 (0.45-0.51 um) 

 GREEN in band 3 (0.53-0.59 um) 

 RED in band 4 (0.64-0.67 um) 

 NEAR INFRARED (NIR) in band 5 (0.85-0.88 um) 

 SHORT-WAVE INFRARED (SWIR 1) in band 6 (1.57-1.65 um) 

 SHORT-WAVE INFRARED (SWIR 2) in band 7 (2.11-2.29 um) 

 PANCHROMATIC in band 8 (0.50-0.68 um) 

 CIRRUS in band 9 (1.36-1.38 um) 

 THERMAL INFRARED (TIRS 1) in band 10 (10.60-11.19 um) 

 THERMAL INFRARED (TIRS 2) in band 11 (11.50-12.51 um) 

II.6.3 Hyperspectral Imaging 

Hyperspectral image is composed of hundreds of contiguous spectral band. Hyperspectral 

imagery allows detection, identification and quantification of surface materials, as well as 

inferring biological and chemical processes. Remose sensing applications using hyperspectral 

images include precision agriculture, e.g., monitoring the types, health, moisture status and 

maturity of crops. 

Example : 

The MODIS sensor consists of 36 spectral bands, covering the wavelength regions ranging 

from the visible, near infrared, short-wave infrared to the thermal infrared. This enabling the 

finer spectral characteristics of the targets to be captured by the sensor. 

II.6.4 Difference between multispectral and hyperspectral  

The main difference between multispectral and hyperspectral is the number of 

bands and how narrow the bands are (see Figure. II.7.). 

Multispectral imagery generally refers to 3 to 10 bands. Each band has a descriptive title. 

https://en.wikipedia.org/wiki/Ultraviolet
https://www.usgs.gov/land-resources/nli/landsat/landsat-8
https://en.wikipedia.org/wiki/Hyperspectral_imaging
https://crisp.nus.edu.sg/~research/tutorial/modis.htm
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Hyperspectral imagery consists of much narrower bands (10-20 nm). A hyperspectral image 

could have hundreds or thousands of bands. In general, they don’t have descriptive channel 

names. 

 

Figure. II.7. Comparison between multispectral and hyperspectral images.  

  [https://www.edmundoptics.com/knowledge-center/application-notes/imaging/hyperspectral-and-multispectral-imaging/]  

II.7 Color Composites 

Colour Composite Images is remote sensing images, which are displayed in three primary 

colours (red, green and blue). It is the assignment of three primary colors; red (R), green (G) 

and blue (B) to three selected bands from multispectral bands. When these three primary 

colours are combined in various proportions, they produce different colours in the visible 

spectrum (see Figure. II.8.). 

 

Figure. II.8. Landsat-5 TM three different colour composites : true colour, 

pseudo-natural colour and false colour composites. [https://ltb.itc.utwente.nl/509/concept/88760] 
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II.7.1 Natural or True Color Composites 

A natural or true color composite is an image resulted from the combination of visible red, 

green and blue bands to the corresponding red, green and blue channels on the computer. In 

the resulting composite image, vegetation appears green, water dark is blue to black and bare 

ground and impervious surfaces appear light grey and brown.  

a. Advantage  

 Colors appear natural to our eyes.  

 

b. Disadvantages  

 Subtle differences in features are difficult to recognize.  

 Natural color images can be low in contrast and somewhat hazy. 

II.7.2 False Color Composites 

A false color image is used to enhance features otherwise invisible or poorly visible to a 

human eye. That is to say, a false color composite is a multispectral image interpretation using 

the standard visual RGB band range (red, green, and blue). Depending on the type of objects 

that need to be emphasized in the image, different color combinations can be used to produce 

the false color imagery. 

Examples : 

There are many different false colored composites which can highlight many different 

features. Table. II.5. shows several color compositions and their characteristics. 

False color composites (band 

combination) 

Interpretation 

Near infrared (red), green (blue), red 

(green). 

Observing changes in plant health. 

Shortwave infrared (red), near infrared 

(green), and green (blue). 

Show floods or newly burned land, often. 

Blue (red), two different shortwave 

infrared bands (green and blue). 

Differentiate between snow, ice, and clouds. 

SWIR-2, SWIR-1, Red (NIR, Red, 

Green) 

Enhances a variety of objects in the image :  

 Water bodies are blue or black which 
makes coastlines appear more distinct.  

 Snow and ice are more easily discernible 
as their dark blue color stands out.  

 Urbanized areas can appear white, gray, or 

purple, providing contrast with the dark 

green vegetation.  
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SWIR, NIR, Red 

Highlights the presence of vegetation, clear-cut 

areas and bare soils, active fires, and smoke; in a 

false color image. 

Monitor forest fires and volcanic activity, and 

other similar phenomena. 

Thermal infrared. Shown in tones of gray to illustrate temperature. 

 

Table. II.5. Example of band combinations and their applications  

II.7.2.1 Vegetation Indices 

Different bands of a multispectral image may be combined to accentuate the vegetated areas.  

a. Ratio Vegetation Index (RVI) 

One such combination is the ratio of the near-infrared band to the red band (see Figure. II.9.). 

This ratio is known as the Ratio Vegetation Index (RVI) 

RVI = NIR/Red 

Since vegetation has high NIR reflectance but low red reflectance, vegetated areas will have 

higher RVI values compared to non-vegetated aeras.  

 

Figure. II.9. Example of RVI image.  
[https://www.arcgis.com/home/item.html?id=bf818b4f3bdb4acba0cb6a9bc74fc78e] 

 

b. Normalised Difference Vegetation Index (NDVI)  

Another commonly used vegetation index is the Normalised Difference Vegetation Index 

(NDVI) (see Figure. II.10.) computed by 

NDVI = (NIR - Red)/(NIR + Red) 

 

Figure. II.10. Landsat image and the corresponding NDVI image.  
[https://mygeoblog.com/2019/04/29/cambodia-1-mapping-vegetation-using-landsat/] 

https://crisp.nus.edu.sg/~research/tutorial/opt_int.htm#multispectral
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II.7.3 Pseudo-natural colour composites  

Combinations that display NIR as green show vegetation in a green colour and are, therefore, 

often called pseudo-natural colour composites. 

II.8 Image fusion  

As previously said, there are two types of images recorded on a satellite: panchromatic images 

and multispectral images. Panchromatic images are characterized by a high spatial resolution 

for distinguishing features, for e.g. in IRS -1C, PAN has a spatial resolution of 5.8 m whereas 

in the case of LISS it is 23.5 m, while multispectral images have high spectral resolution. 

Many applications require images withboth high spatial and high spectral resolutions.  Image 

Fusion is the combination of low resolution multispectral and high-resolution panchromatic 

images to form a new high-resolution multispectral images. The objective is to improve the 

accuracy of image interpretation and analysis by making use of complementary information.  

The commonly applied Image fusion techniques are : 

 Intensity Hue Saturation (IHS) Transformation  

 The Hue Saturation Value (HSV) 

 Principal Component Analysis (PCA)  

 Brovey Transform  

 Band Substitution 

II.8.1 IHS Transformation 

The IHS transformation is very useful for image processing because it allows merging high 

spatial resolution panchromatic image with lower spatial resolution hyper spectral image. 

Thus, the resulted transformed image shows the spatial details of the panchromatic image 

while maintaining much of the spectral content of the original color image (see Figure. 

II.11.).  

 

Figure. II.11. IHS image transformation : (a) Landsat TM falsecolor composite image of 

TM bands 1 (displayed in blue), 3 (displayed in red), and 4 (displayed in green). (b) 

SPOT panchromatic image. (c) Landsat TM and SPOT panchromatic images IHS-

merged.  

[https://www.asprs.org/wp-content/uploads/pers/1994journal/nov/1994_nov_1369-1374.pdf] 



Chapter II.                                                                                                   Aerial and Satellite Images 

46 
 

II.8.2 The HSV  

HSV method is one of the most commonly used technique for remote sensing image fusion. 

HSV improve the spatial resolution for the original multispectral image by preserving the 

spectral information characteristics. The HSV method consists of transforming the R, G and B 

bands of the multispectral image into HSV components (see Figure. II.12.). 

 

Figure. II.12. HSV image fusion : (a) QuickBird multi spectral image. (b) QuickBird 

panchromatic image. (c) HSV image fusion.  

[https://www.spiedigitallibrary.org/conference-proceedings-of-spie/10605/106051N/A-new-improved-HSV-image-fusion-

method/10.1117/12.2291610.short] 

 

II.8.3 The PCA method 

The PCA method is a pre-processing transformation that creates new images from the 

uncorrelated values of different image bands. This allows describing the data more efficiently 

than the original band reflectance values that are is usually strongly correlated from one band 

to the other.  

 

Figure. II.13. PCA image transformation : (a) The original input satellite image. (b) The 

reduced PCA image.  

[https://eo.belspo.be/en/principal-component-analysis] 
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Principal component enhancement techniques are particularly appropriate in areas where little 

a priori information concerning the region is available. It involves ways for identifying and to 

show patterns in data, in such a way as to highlight their similarities and differences, and thus 

reduce dimension without loss of data. 

II.8.4 Band Substitution  

To highlight specific features, one or more of the RGB bands can be substituted for another, 

such as infrared, or near infrared, which are not visible to the human eye. 

II.8.5 Brovey Transform  

Brovey transform allows combining the data acquired by different sensors. It preserves the 

spatial information of PAN image well and optimise the visual contrast. However distortion 

of the spectral information is significant in this method. 

II.9 Band ratioing  

Band ratioing is a standard image processing technique that enhance the spectral differences 

between bands by reducing environmental spatial radiance variations that are proportionally 

constant between bands. These variations are generally attributable to terrain illumination, 

ground albedo, topographic slope and aspect, shadows, or seasonal changes in sunlight 

illumination angle and intensity. These allow best identification of surface materials or land 

use in a remotely sensed image. Band ratioing consists in dividing one spectral band by 

another and produces an image that provides relative band intensities.  
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III.1  Image processing  

Processing is a method to perform some operations on an image, in order to get an enhanced 

image or to extract some useful information from it. It is a type of signal processing in which 

input is an image and output may be image or characteristics/features associated with that 

image. There are several Image processing techniques used in Earth observation, and we tend 

to categorize them into four broad categories:  

 Preprocessing ; 

 Transformation ;  

 Correction ; 

 Classification.  

III.2  Pre-processing of satellite images 

Prior to data analysis, initial processing on the raw data is usually carried out to correct for 

any distortion due to the characteristics of the imaging system and imaging conditions. Pre-

processing operations, sometimes referred to as image restoration and rectification, are 

intended to correct for sensor- and platform-specific radiometric and geometric distortions of 

data (see Figure. III.1.).  

 

Figure. III.1. Example of presprocessing of remote sensing image.  

[https://www.onestopgis.com/Aerial-Photography/Digital-Imaging/Digital-Image/6-Pre-Processing-Remotely-Sensed-

Images.html] 

Some typical pre-processing operations are : 

 Radiometric Correction ; 

 Atmospheric Corrections ; 

 Geometric Correction . 

III.2.1  Radiometric Correction 

Radiometric is a pre-processing technique to reconstruct physically calibrated values by 

correcting the spectral distortions caused by sensor specific errors, sun angle, topography and 

the atmosphere condition during recording (see Figure. III.2.). 
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Figure. III.2. Landsat image befor (a) and after (b) radiometric correction.  

[https://slideplayer.com/slide/7946813/] 

Radiometric distortions usually come from various sources including :  

 Variations in scene illumination; 

 Variations in viewing geometry ; 

 Variations in atmospheric conditions ; 

 Variations depending on the specific sensor and platform noise and response used to 

acquire the data;  

 Image transformation to a specific map projection system. 

Radiometric corrections are classified into two broad categories:  

a. Sun Angle/Topography Radimetric Corrections ;  

b. Sensor Irregularities Radiometric Corrections. 

 

III.2.1.1  The Sung Angle/Topography radiometric corrections 

Correct the effects of diffusion of sunlight, especially in the water surface and mountains, by 

estimating the shading curve. 

III.2.1.2  Sensor irregularity corrections  

Sensor irregularity corrections consist in removing radiometric noise from changes in sensor 

sensitivity or degradation of the sensor. 

III.2.2  Atmospheric Corrections 

Atmospheric correction is classified into two types (see Figure. III.3.) : 

 Absolute correction ; 

 Relative correction. 
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Figure. III.3. Landsat image befor (a) and after (b) athmospheric correction.  

[https://slideplayer.com/slide/7946813/] 

III.2.2.1  Absolute correction 

Absolute correction considers several time-dependent parameters, including solar zenith 

angle, the total optical depth of the aerosol, irradiance at the top of the atmosphere, and sensor 

viewing geometry to correct the atmospheric distortions. Therefore, the atmospheric 

correction is so complicated and the exact measurement of atmospheric condition is difficult. 

III.2.2.2  Relative Correction 

Relative correction is to normalize multi-temporal data taken on different dates in a given 

scene to a selected reference data at specific time. 

The following are typical techniques for relative image correction. 

 Adjustment of average and standard deviation values ; 

 Conversion to normalized index ; 

 Histogram matching ; 

 Least square method. 

III.2.3  Geometric correction 

Geometric correction is to correct geometric errors due to the data acquisition system and to 

register the satellite image to a map projection (see Figure. III.4.). The aim is to have a pixel 

or a scene with the exact location or grid point on the ground with two different images taken 

at other times. 

 

Figure. III.4. IKONOS image befor (a) and after (b) geometric correction.  
[https://a-a-r-s.org/proceeding/ACRS2000/Papers/DPH00-12.htm] 
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Two types of geometric distortions can be distinguished : internal and external distortions.  

a. Internal distortions 

Caused by sensor, such as lens distortion, misarrangement of detectors, variation of sampling 

rate etc. 

b. External distortions 

Caused by external parameters other than sensor, including variation of attitude and position 

of platform, earth curvature, topographic relief etc. 

There are three types of geometric correction : system correction, mapping transformation, 

and combined method. 

III.2.3.1  System correction 

Geometric correction using the geometry of the sensor with sensor calibration data and 

attitude/positioning measurements. But this is not enough to produce geo-coded image with 

high accuracy. 

III.2.3.2  Mapping transformation 

Determination of transformation function, usually the second of third order polynomials to 

transform image to map coordinate system based only on ground control points. 

III.2.3.3  Combined method 

First, system correction is adopted to avoid major systematic distortions and then mapping 

transformation with simpler functions such as affine or pseudo-affine is applied. 

III.3  Image Transformation 

Image transformations typically involve the manipulation of multiple bands of data, whether 

from a single multispectral image or from two or more images of the same area acquired at 

different times. Two procedures of image transformation will be presented depending on the 

specific purposes : image enhancement and feature extraction. 

III.3.1  Image Enhancement 

For many remote sensing applications, the corrected image is also treated by different image 

enhancement techniques to improve the quality and facilitate the analysis : feature extraction 

and image interpretation. Remote sensing image enhancement techniques improve the 

visibility, contrast, intensity, and edge information of the image and removing noise while 

preserving the original reflectance values (see Figure. III.5.).  
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Figure. III.5. Sentinel-2 image befor (a) and after (b) enhancement.  

[https://www.mdpi.com/2072-4292/12/10/1555] 

The more commonly used techniques of image enhancement are : 

 Eliminating noise;  

 Contrast stretch ; 

 Revealing blurred details;  

 Adjusting levels to highlight features of an image. 

 Density slicing ; 

 Edge enhancement ; 

 Spatial filtering ; 

 Fourier analysis ; 

 Multi-image manipulation band rationing, differencing, principal components, 

canonical components, vegetation components, intensity-hue-saturation. 

Image enhancement techniques can be divided into two broad categories: 

 Spectral enhancement ; 

 Spatial enhancement. 

III.3.1.1  Spectral enhancement  

Relies on changing the gray scale representation of pixels to give an image with more contrast 

for interpretation (see Figure. III.6.). It applies the same spectral transformation to all pixels 

with a given gray scale in an image.  

 

Figure. III.6. Landsat image befor (a) and after (b) spectral enhancement.  
[https://www.slideserve.com/drago/remote-sensing-part-2] 



Chapter III.                                                                                    Remote Sensing Image Processing 

55 
 

Contrast is an important characteristic generally refers to the difference in luminance or grey 

level values in an image, larger the range, greater the contrast, more easy it is to interpret the 

image, and vice versa. Satellite images require contrast improvement. 

Contrast enhancement techniques, i.e., grey level stretching, expand the range of brightness 

values in an original input image to make use of the total dynamic range or sensitivity of the 

output device. The aim is to imrove the visual contrast between two areas of different uniform 

densities. This increases the discrimination ability between areas initially having a small 

difference in density. 

We distinguished two types of contrast enhancement : 

 Linear Contrast Stretch ;  

 Non-Linear Contrast Enhancement. 

 

a. Linear Contrast Stretch  

Linear Contrast Stretch is the simplest contrast enhancement technique which consists in 

expanding uniformly the intensity pixel values in the original image to exploite the total range 

of values (see Figure. III.7.). 

 

Figure. III.7. Landsat image befor (a) and after (b) Linear Contrast Stretch  

Enhancement and their corresponding histogram.  
[https://www.slideshare.net/pabitramani/image-enhancement-technique-digital-image-analysis-in-remote-sensing] 

 

b. Non-Linear Contrast Enhancement  

In these methods, the input and output data values follow a non-linear transformation (see 

Figure. III.8.). The non-linear contrast enhancement techniques is useful for enhancing the 

colour contrast between the nearly classes and subclasses of a main class.  
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Figure. III.8. Landsat image befor (a) and after (b) Non-Linear Contrast Stretch  

Enhancement and their corresponding histogram.  
[https://www.slideshare.net/pabitramani/image-enhancement-technique-digital-image-analysis-in-remote-sensing] 

Three methods of non-linear contrast enhancement techniques can be distinguished:  

 Histogram Equalizations (HE),  

 Adaptive Histogram Equalization (AHE)  

 Homomorphic Filters (HF).  

III.3.1.2  Spatial enhancement 

Spatial enhancement is the enhancement of the image space that divides an image into 

uniform pixels according to the spatial coordinates with a certain resolution (see Figure. 

III.9.). It consists in defining homogeneous regions based on linear edges. The spatial domain 

methods perform operations on pixels directly. 

 

Figure. III.9. Satellite image befor (a) and after (b) Spatial Enhancement.  
[https://www.gisoutlook.com/2019/10/image-enhancement-part-iii-spatial.html] 

There are several purposes that underlie spatial enhancement techniques:  

 To improve interpretability of image data  

 To aid in automated feature extraction  

 To remove and/or reduce sensor degradation  

 Restore imagery by avoiding noises 

 Enhance the imagery for better interpretation 

 Extract features such as edges and lineaments 
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Spatial enhancement techniques are based on the concept of spatial frequency within an 

image. Spatial frequency is the manner in which gray-scale values, i.e., brightness value, 

change relative to their neighbors within an image. We can distinguish two types : 

 Low spatial frequency area : If there is a slowly varying change in gray scale in an 

image from one side of the image to the other (once a given area in an image). 

 

 High spatial frequency : If pixel values vary radically for adjacent pixels in an 

image, the image is said to have a high spatial frequency.  

Figure. III.10. shows examples of zero, high and low spatial frequencies. 

 

Figure. III.10. Images with zero (a), low (b), and high (c) spatial frequencies.  
[https://slideplayer.com/slide/12530969/] 

Spatial enhancement involves the enhancement of either low or high frequency information 

within an image. Two major methods commonly used in spatial enhancement are:  

a. Filtering in the domain of image space (Convolution) 

Convolution involves the passing of a moving window over an input image and producing a 

new image where each pixel in this resulted image is a function of the original pixel values 

within the spatial neighbor.  

The three types of spatial filters used in remote sensor data processing are :  

 Low pass filters (Low-Frequency Filtering);  

 Band pass filters ; 

 High pass filters (High-Frequency Filtering). 

 

 Low pass filters   

Low pass filters block the high spatial frequency detail by using "blurring" filter that 

highlights low frequency parts of an image while minimizing the high frequency components.  
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                       Figure. III.11. Images befor (a) and after (b) low pass filter.  
[https://slideplayer.com/slide/9451846/] 

 Band pass filters  

Band pass filters allows only signals within a certain band to pass, attenuates the frequencies 

below a threshold and above another threshold to pass (see Figure. III.11.). 

  High-pass filters (High-Frequency Filtering)   

Spatial high-pass filtering remove the slowly varying components and enhance the high-

frequency local variations (see Figure. III.12.). The enhancement of high frequency 

information within an image is often called edge enhancement. It highlights edges in the 

image while preserving the quality of the original image.  

 

               Figure. III.12. Images befor (a) and after (b) high pass filter.  
[https://slideplayer.com/slide/9451846/] 

 

b. Filtering in the domain of spatial frequency (Fourier Transform)  

The Fourier transformation is used to convert from image space domain to spatial domain of 

which frequency is controlled by low pass, high pass and band pass filters. After such 

frequency filtering process, image will reconstructed by using an inverse Fourier 

transformation. Low pass filters will cut off high frequency to allow the output of only low 

frequency image, while high pass filters will cut off low frequency noises such as stripe noise 

or shading. 

III.3.2  Feature Extraction 

Feature extraction is the operation to extract various image features for identifying or 

interpreting meaningful physical objects from images (see Figure. III.13.). 
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Figure. III.13. Landsat image (a) and the extracted land cover feature image.  
[https://www.mdpi.com/2220-9964/5/3/31/htm] 

Features are classified into three types. 

 Spectral features ; 

 Geometric features ; 

 Textural features. 

III.3.2.1  Spectral features:  

Color, tone, ratio, spectral index, principle components and normalized vegetation index are 

widely used. 

III.3.2.2  Geometric features:  

Spatial filtering of edge detection is commonly used to extract linear features such as roads, 

geological linearments, boundaries of agricultural fields etc. 

III.3.2.3  Textural features 

Texture is one of the important characteristics aid in visual image interpretation, especially for 

high spatial resolution imagery. It is used in identifying objects, regions of interest, or pattern 

homogeneity in an image (see Figure. III.14.).  

 

Figure. III.14. Landsat image (a) and the extracted texture features (b).  
[https://www.mdpi.com/2072-4292/6/8/7339/htm] 

III.4  Image Classification 

Image classification is the process of assigning land cover classes to pixels. For example, 

classes include water, urban, forest, agriculture, and grassland. Each class of landcover is 
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referred to as a "theme"and the product of classification is known as a "thematic map" (see 

Figure. III.15.). 

 

                   Figure. III.15. Landsat image (a) and the classification (b).  
[https://www.semanticscholar.org/paper/Unsupervised-Classification-of-Landsat-8-OLI-Based-   Choi-

Noh/eaa803d80bb3928dede7b8f111d1f64999f5215c] 

The 2 main types of image classification techniques in remote sensing are: 

 Unsupervised image classification 

 Supervised image classification 

III.4.1  Supervised classification   

In supervised classification, the spectral features of each land cover class (ground truth data) 

are extracted from the image. These areas are known as the "training areas" inform the remote 

sensing software of major land cover and vegetation classes in the image for a supervised 

classification (see Figure. III.16.). Every pixel in the input image is classified as belonging to 

one of the classes depending on how close its spectral features are to the spectral features of 

the training areas. 

 

Figure. III.16. Ground truth image (a) with training sites, shown as colored 

polygons and supervised classification (b). 
[http://blogs.ubc.ca/katerynabaranovasgis/2016/11/03/supervised-image-classification/] 
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The three basic steps for supervised classification are: 

 Select training areas 

 Generate signature file 

 Classify 

Most common classification algorithms are: 

 Maximum likelihood 

 Minimum-distance 

 Principal components 

 Support vector machine (SVM) 

 Iso cluster 

III.4.2  Unsupervised classification  

Classification with only spectral features without use of ground truth data. Clustering is an 

unsupervised classification in which a group of the spectral values will regrouped into a few 

clusters with spectral similarity (see Figure. III.17.). 

 

Figure. III.17. Ground truth image (a) the unsupervised classification with 6 

clusters (b) and with 8 clusters (c). 
[https://medium.com/dataseries/unsupervised-learning-cd0b78adbf7c] 

Unsupervised classification consists in grouping automatically the pixels in the image into 

different clusters, depending on their spectral features. Each cluster will then be assigned a 

landcover type by the analyst. 

The two basic steps for unsupervised classification are: 

 Generate clusters 

 Assign classes 

Some of the common image clustering algorithms are: 

 K-means 

 ISODATA 
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IV.1  What is Geographic Information System (GIS)   

GIS is a computer based system designed to aid in the collection, manage, strorage, analysis, 

modelling (spatial scenario), representation, display, output, and distribution of spatial data 

and information.  

IV.2  Basic concepts of GIS 

IV.2.1  GIS data 

Data in a GIS represent a simplified view of physical entities, the roads, mountains, accident 

locations, or other features we wish to identify (see Figure. IV.1.).  

 

Figure. IV.1. GIS data. 
[https://twitter.com/leicageosa/status/1047051652677734400] 

In addition, data include information on the spatial location and extent of the entities, and 

information on their nonspatial properties. 

IV.2.2  Entity  

Each entity is represented by a spatial feature or cartographic object in the GIS. Only a subset 

of essential characteristics of any entity are subjectively chosen and recorded by the spatial 

data developer that support the intended use at the desired level of detail and accuracy (see 

Figure. IV.2.). 

 

Figure. IV.2. Feature representations. 
[https://www.gisoutlook.com/2020/04/vector-data-model-of-gis.html] 
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As illustrated in Figure. IV.3., we may represent landcover in a region by a polygons.  

IV.2.3  Feature   

Feature is a single entity in GIS that has both geometry and attribute data. The attribute data 

can be just a single ID number or it can encompass all kinds of other data about the feature. A 

GIS helps us analyze the spatial relationships and interactions between different features, and 

model spatial processes. 

IV.2.4  Objects  

Objects are abstract representations of reality that we store in a spatial database.  

IV.2.5  Coordinates  

A GIS quantifies the locations of spatial features by recording their coordinates, numbers that 

describe the position of these features on Earth. Coordinates are used to define the spatial 

location and extent of geographic objects. Single or groups of coordinates are organized to 

represent the shapes and boundaries that define the objects (see Figure. IV.3.).  

 

Figure. IV.3. Features and their coordinate spatiales. 
  [https://geogra.uah.es/patxi/gisweb/GISModule/GIST_Vector.htm] 

Three types of coordinate systems can be distinguished : 

 Standard coordinate systems ; 

 Cartesian systems ;   

 Spherical coordinate systems. 

 

IV.2.5.1  Standard coordinate systems  

Coordinates are usually expressed in one of many standard coordinate systems. The 

coordinate systems are usually based upon standardized map projections that unambiguously 

define the coordinate values for every point in an area (see Figure. IV.4.). 
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Figure. IV.4. Standard coordinate systems. 
[https://www.esri.com/arcgis-blog/products/arcgis-pro/mapping/coordinate-systems-difference/] 

 

 A geographic coordinate system (GCS) : is a reference framework that defines 

the locations of features on a model of the earth. It’s shaped like a globe—

spherical. Its units are angular, usually degrees. 

 A projected coordinate system (PCS) : is flat. It contains a GCS, but it converts 

that GCS into a flat surface, using math (the projection algorithm) and other 

parameters. Its units are linear, most commonly in meters. 

 

IV.2.5.2  Cartesian systems  

Spatial data in a GIS most often use a Cartesian coordinate system. Cartesian systems define 

two or three orthogonal (right angle, or 90°) axes in a plane (see Figure. IV.5.).  

Three dimensional Cartesian systems in addition define a z axis, orthogonal to both the x and 

y axes. The origin is defined with zero values at the intersection of the orthogonal axes.  

 

Figure. IV.5. Cartesian coordinate systems. 
[https://www.rsgisworld.com/2018/08/] 

 

IV.2.5.3  Spherical coordinate systems  

Coordinate data may also be specified in a spherical coordinate system. The most common 

spherical system uses two angles of rotation and a radius distance, r, to specify locations on a 

modeled earth surface (see Figure. IV.6.).  
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Figure. IV.6. Spherical coordinate system. 
[https://en.wikipedia.org/wiki/File:Spherical_Coordinates_(Colatitude,_Longitude).svg] 

 

IV.2.6  Attribute data  

Attribute data is a non spatial information about a geographic feature in a GIS, such as a 

name, color, pH, or cash value, depth, weight, owner, vegetation type, or land use. Keys, 

labels, or other indices are used so that the coordinate and attribute data may be viewed, 

related, and manipulated together (see Figure. IV.7.). 

Attribute data usually stored in a table, arranged in rows and columns, and linked to the 

feature by a unique identifier. Attribute data complement coordinate data to define 

cartographic objects. 

 

Figure. IV.7. Descriptive Attributes data. 
[http://www.glyfac.buffalo.edu/courses/gly560/Lessons/OLD/hbef_geology/ArcHydro-IntroGIS.htm] 

Attributes can be categorized as nominal, ordinal, or interval/ratio attributes. 

IV.2.6.1  Nominal attributes  

Nominal attributes are variables that provide descriptive information about an object. 
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Exemple :  

The color is recorded for each hydrant, vegetation type, a city name, the owner of a parcel, or 

soil series.  

IV.2.6.2  Ordinal attributes  

Ordinal attributes imply a ranking or order by their values. An ordinal attribute may be 

descriptive, such as high, mid, or low, or it may be numeric.  

Example :  

An erosion class may be given a value from 1 to 10. The order reflects only rank, and not the 

scale.  

IV.2.6.3  Interval/ratio attributes  

Interval/ratio attributes are used for numeric items where both rank order and absolute 

difference in magnitudes are represented 

Exemple :  

Area, length, weight, height, or depth are a few examples of attributes that are represented by 

interval/ratio variables. 

IV.3  GIS Components 

A GIS is composed of hardware, software, data, humans, and a set of organizational protocols 

components. These components must be well integrated for effective use of GIS (see Figure. 

IV.8.).  

 

Figure. IV.8. GIS components. 
[https://classhall.com/lesson/components-of-geographic-information-system-gis/] 
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IV.3.1  Hardware for GIS  

Because GIS require large volumes of data that must be entered to define the shape and 

location of geographic features, GIS hardware often have large data storage capacities, fast 

computing speed, and ability to capture coordinates.  High computational ressources are 

required because spatial analyses are often applied over large areas and/or at high spatial 

resolutions.  

IV.3.2  GIS Software  

Software tools and packages for GIS are unique in their ability to manipulate coordinates and 

associated attribute data. GIS software provides the tools to manage, analyze, and effectively 

display and disseminate spatial information and reporting the results of spatial analysis. In 

many instances GIS is the only way to solve spatially-related problems. GIS software 

provides the specific tools the following tasks : 

 Collect qualitative or quantitative information on the nonspatial attributes of 

geographic features ; 

 View and edit data ; 

 Manipulate data to generate and extract the information we require ; 

 Produce the materials to communicate the information we have developed.  

 GIS software packages. 

The most common GIS softwares are : 

 ArcGIS Pro. 

 ArcGIS Desktop 

 QGIS 

 MapInfo Professional 

 Global Mapper 

 Maptitude 

 Esri ArcGIS. 

 Google Earth Pro. 

 Google Maps API. 

 Citymapper. 

IV.3.3  Data and GIS  

IV.3.3.1  Sources of data  

Two types of data are input into a GIS, spatial and attribute. The data input process consists in 

encoding both types of data into the GIS database formats. A wide variety of data sources 

exist for both spatial and attribute data. The most common general sources for spatial data 

are : 

 Aerial photographs; 

 Remotely-sensed imagery; 

 Hard copy maps; 
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 Point data samples from surveys; and 

 Existing digital data files. 

 

IV.3.3.2  Data input techniques 

There are several methods of entering the spatial data into a GIS that can be used singly or in 

combination (see Figure. IV.9.). There are at least four basic procedures whci are: 

 Manual digitizing; 

 Automatic scanning; 

 Entry of coordinates using coordinate geometry; and the 

 Conversion of existing digital data. 

 

Figure. IV.9. Example of data input technique. 
[https://gis-university.com/gis-data-input-techniques/] 

 

IV.3.3.3  Data editing and quality assurance 

Data editing aim to verify the errors that arise during the encoding of spatial and non-spatial 

data. It is a time interactive consuming process. 

Several types of errors can occur during data input. They can be classified as: 

 Incompleteness of the spatial data 

This includes missing points, line segments, and/or polygons. 

 Locational placement errors of spatial data 

These types of errors usually are the result of careless digitizing or poor quality of the original 

data source. 

 Distortion of the spatial data 

This kind of error is usually caused by base maps that are not scale-correct over the whole 

image, e.g. aerial photographs, or from material stretch, e.g. paper documents. 

 Incorrect linkages between spatial and attribute data 

This type of error is commonly the result of incorrect unique identifiers (labels) being 

assigned during manual key in or digitizing.  
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 Attribute data is wrong or incomplete 

Often the attribute data does not match exactly with the spatial data. This is because they are 

frequently from independent sources and often different time periods.  

IV.4  Spatial data model  

Spatial data model is the set of objects in a spatial database plus the relationships among 

them. The purpose of a spatial data model is to provide a formal means (set of rules and/or 

constructs) of representing and manipulating spatially referenced information in a computer. 

There are two main data models (see Figure. IV.10.):  

 Raster data models ; 

 Vector data models. 

 

Figure. IV.10. GIS data model : Raster model (a) and Vector model (b). 
[http://www.newdesignfile.com/post_vector-and-raster-data-model_15523/] 

IV.4.1  Vector data models  

Vector data model use discrete elements such as points, lines, and polygons to represent the 

geometry of realworld entities (see Figure. IV.10. (b)).  

Exemple :  

Farm fields, roads, wetlands, cities, and census tracts are examples of entities that are often 

represented by discrete objects.  

There are three basic types of vector objects: points, lines, and polygons.  

 Points : contain only a single coordinate pair to represent the location of an entity. 

Theyare often used to define the locations of “small” objects such as wells, 

buildings, or ponds.  

 Lines : may be used to represent linear objects, for example, rivers or roads, or to 

identify the boundary between what is a part of the object and what is not a part of 

the object.  

 Polygons : also called areas, are two-dimensional features that are used to 

represent features such as city boundaries, vegetation communities. 
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Vector data models can be structured with two common data structures :  

 The spaghetti data model ;  

 The topological data model. 

 

IV.4.1.1  The spaghetti model   

The spaghetti model represents each point, line, and/or polygon feature by a string of X, Y 

coordinate pairs. Spatial relationships are not explicitly encoded within the spaghetti model; 

rather, they are implied by their location. This results in a lack of topological information, 

which is problematic if the user attempts to make measurements or analysis.  

IV.4.1.2  The topological data model  

Topology is a set of rules (an informative geospatial property) that model (describes) the 

relationships between neighboring points, lines, and polygons and determines how they share 

geometry. Topology allows the computer to rapidly determine and analyze the spatial 

relationships of all its included features.  

Three basic topological are considered :  

 Connectivity : describes the arc-node topology for the feature dataset.  

 Area definition : Area definition states that an arc that connects to surround an 

area defines a polygon, also called polygon-arc topology.  

 Contiguity : Is based on the concept that polygons that share a boundary are 

deemed adjacent, or contiguous. Specifically, polygon topology requires that all 

arcs in a polygon have a direction (a from-node and a to-node), which allows 

adjacency information to be determined. 

 

IV.4.1.3  Advantages and disadvantages of the Vector Model 

  

a. Advantages  

 Better representations of reality due to the accuracy and precision of points, 

lines, and polygons.  

 Provides an increased ability to alter the scale of observation and analysis.  

 Zooming deep into a vector image does not change the view of a vector 

graphic. 

 Vector data tend to be more compact in data structure. 

 File sizes are typically much smaller than their raster counterparts.  

 Topology is inherent in the vector model and it results in simplified spatial 

analysis (e.g., error detection, network analysis, proximity analysis, and spatial 

transformation. 

 

b. Disadvantages  

 The data structure tends to be much more complex than the simple raster data 

model. The location of each vertex must be stored explicitly in the model. 
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 The implementation of spatial analysis can also be relatively complicated due 

to minor differences in accuracy and precision between the input datasets.  

 The algorithms for manipulating and analyzing vector data are complex and 

can lead to intensive processing requirements, particularly when dealing with 

large datasets. 

IV.4.2  Raster data models  

Raster data models consists of a regular set of cells in a grid pattern (see Figure. IV.10. (a)). 

The entities of interest are represented by attribute values associated with each cell location. 

Each cell in a raster carries a single value, which represents the characteristic of the spatial 

phenomenon at a location denoted by its row and column. The raster model is used most 

commonly with variables that may change continuously across a region such as elevation, 

mean temperature, slope, average rainfall, cumulative ozone exposure, or soil moisture. 

IV.4.2.1  Advantages and disadvantages of the Raster Model 

 

a. Advantages  

 The technology required to create raster graphics is inexpensive and ubiquitous 

(a digital camera, satellites). 

 The relative simplicity of the underlying data structure. Each grid location 

represented in the raster image correlates to a single value (or series of values 

if attributes tables are included).  

 

b. Disadvantages  

 Raster files are very large.  

 The geometric transformations during map reprojection affect the raster 

graphics quality. 

 Changing map projections will alter the size and shape of the original input 

layer and frequently result in the loss or addition of pixels. 

 Raster data model is not suitable for analyzing multiple raster graphics 

produced at differing scales and pixel resolutions. 

IV.4.3  Comparison of Raster and Vector Data Models 

Characteristic Vector Model Raster Model 

Data structure  Usually complex  Usually simple 

Storage requirement  Smaller for most 

data sets 

 Larger for most data 

sets without 

compression 

Coordinate conversion  Simple   May be slow due to 

data volumes, and 

require resampling 
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Analysis  Preferred for 

network analysis, 

many others spatial 

operations more 

complex 

 Easy for continuous 

data, simple for 

many layer 

combinations 

Spatial precision  Limited only by 

positional 

measurements 

 Floor set by cell 

size 

Accessibility  Often complex  Easy to modify or 

program, due to 

simple data 

structure 

Display and output  Maplike, with 

continuous curves, 

poor for images 

 Good for images, 

but discreate 

features may show 

"stairstep" edges 

 

Table. IV.1. Comparison between Raster and Vector Data Models 

IV.5 GIS Spatial data organization  

GIS software organize data in thematic data layers. Thematic data layers are information data 

sets that have a common feature or attribute for a given set of cartographic objects in the 

region of interest placed in the same layer of spatial data. Each theme represents a data set for 

a defined area (see Figure. IV.11.).  

In any GIS project a variety of data layers will be required that are commonly defined based 

on the needs of the user and the availability of data.  

Two types of data are required for each layer, attribute and spatial data.  

 

Figure. IV.11. GIS spatial data organization : thematic data layers. 
 [https://www.admitnetwork.org/work-packages/gis-gps/]  

 



Chapter IV.                                                                              Geographic Information System (GIS) 

75 
 

IV.6  Spatial analyse methodes   

The process of examining the locations, attributes, and relationships of features in spatial data 

through statistical analysis and other analytical techniques in order to address a question or 

gain useful knowledge (see Figure. IV.12.).  

 

Figure. IV.12. Example of GIS Spatial data analysis. 
[https://www.esri.com/arcgis-blog/products/product/analytics/how-to-perform-spatial-analysis/] 

Spatial analysis extracts or creates new information from spatial data, and then explore and 

examine those results with spatial correlation derived by computer processing. 

       Common types of analysis include: 

 Location, quantity and density of features 

 Spatial relationships and patterns 

 Temporal change 

IV.7  Spatial database  

A spatial database is a database that includes spatial data that represents objects defined in a 

geometric space (points, lines and polygons), along with tools for accessing, storing, and 

managing such data (see Figure. IV.13.). 

 

Figure. IV.13. GIS database. 
[https://www.esri.com/news/arcnews/winter0809articles/the-geodatabase.html] 

https://en.wikipedia.org/wiki/Database


Chapter IV.                                                                              Geographic Information System (GIS) 

76 
 

 

IV.7.1  Database management system (DBMS)  

A software system, i.e., computer programs, serves as an interface between users and their 

databases (see Figure. IV.14.). It designed to: 

 Organize data tables in a flexible manner, 

 Provide tools to add, modify or delete data from the database, 

 Query the data, 

 Produce reports summarizing selected contents.  

 

Figure. IV.14. GIS DBMS. 
[https://www.semanticscholar.org/paper/Fuzzy-Object-Relational-Database-Management-System-Al-Kandari-

Alhouli/40b5250a389732db5decf9e998a69b05f7d801e7] 

IV.7.2  Factors Affecting the Adoption of GIS systems 

The capacity of GIS systems to store, retrieve, analyse, model and map large areas with huge 

volumes of spatial data has led to an extraordinary proliferation of GIS technologies in several 

applications and has been emerging in many professional work environments. 

The adoption of Geographic Information Systems (GIS) Technology has been emerging in 

many professional work environments due to the following factors : 

 The developement of the remarkable positioning technology, generically known as 

Global Navigation Satellite Systems (GNSS). GNSS are indispensable tools in 

commerce, planning, and safety ; 

 The development of Spatial data display and analysis capabilities due to the the 

computing improvements ; 

 Faster computers with more storage. Powerful field computers are lighter, faster, 

more capable, and less expensive ; 

 The increased interconnectedness via WiFi and mobile networks;  

 Costs decrease and performance increases at dizzying rates ; 

 GIS on rugged, field-portable computers has been particularly useful in field data 

entry and editing. 
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 Advances in image technologies, collection and interpretation with more accurate 

maps were available.  

 The developement of many techniques for extracting information from image data, 

and ensuring this information faithfully represents the location, shape, and 

characteristics of features on the ground.  

Thus, advances in these three key technologies imaging, GNSS, and computing, have 

substantially aided the development of GIS. 

IV.7.3  GIS Application 

GIS technology has been emerging over the last several decades as one of the fastest-growing 

technologies in professional disciplines (see Figure. IV.15.). It has been used to solve several 

problems in many applications such as : 

 Agriculture : Farm management – Pest/Disease tracking – Crop monitoring – Yield 

prediction – Soil analysis 

 Disaster Risk Reduction and Management : Vulnerability Assessment • Hazard 

Modeling • Easements and Relocation Schemes utilities management 

 Natural Resource Management : Forestry • Ecology • Mining • Fisheries • 

Biodiversity Conservation Ecosystems modelling 

 Identify the source, location, and extent of adverse environmental impacts 

 Planning and Economic Development :  

 Land Use/Zoning • Population Forecast • Market Analysis • Tax Mapping • 

Transportation and infrastructure  landscape assessment and planning Market analysis  

 Ecosystems Services Accounting : Ecosystem Accounts • Opening-Closing stocks • 

Economic Valuation • Scenario Modeling  

 
Figure. IV.15. GIS applications. 

[https://www.latestgkgs.com/geographical-information-system-gis-3627-a] 
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V.1 What is ArcGIS ?  

ArcGIS is a geographical information system (GIS) software, developed by Esri 

(Environmental Systems Research Institute), that allows handling, viewing, editing, managing 

and analyzing geographic information by visualizing geographical statistics through layer 

building maps in which each category of spatial feature is a separate layer.  

V.2 What can do with ArcGIS ? 

ArcGIS allows you to: 

 Create, share and use maps; 

 Gather geographic information; 

 Create and manage geographic databases; 

 Solve problems with spatial analysis; 

 Create map-based applications; 

 Communicate and share information through the power of 

 Geography and visualization. 

 

V.3 ArcGIS software? 

 

Figure.V.1. Principal applications of ArcGIS. 

The ArcGIS software includes a suite of integrated applications (see Figure. V.1.): 

V.3.1 ArcCatalog 

ArcCatalog facilitates the organization and management of all GIS data (maps, datasets, 

models, etc.). Like windows explorer, ArcCatalog is considered as an "explorer" of 

cartographic data. It allows you to organize, preview, search, describe (metadata) geographic 

data. It allows: 

 Exploration of geographical and attribute data. 

 The highlighting of geographical data. 

 Data management (create, define, move, rename, delete...). 

 The description of the data (metadata). 
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V.3.2 ArcMap  

ArcMap is the principal application of ArcGIS Desktop. It is subdivided into two interfaces 

(see Figure. V.2.):  

 Visualization and processing (analysis, editing, etc.) of geographic data in the “data 

view” window ;  

 Map layout in the “layout view” window. 

 

 
 

Figure. V.2. Presentation of ArcMap interface. 
[https://desktop.arcgis.com/fr/arcmap/latest/map/main/a-quick-tour-of-arcmap.htm] 

V.3.3  ArcGlobe  

ArcGlobe allows 3D visualization of the larger study areas with global extents (see Figure. 

V.3.).  
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Figure. V.3. Presentation of ArcGlobe interface. 
[https://desktop.arcgis.com/fr/arcmap/latest/extensions/arcglobe/the-arcglobe-user-interface.htm] 

V.3.4  ArcToolbox 

The ArcToolbox brings together all the geoprocessing tools useful for performing operations 

on geographic data (see Figure. V.4.). It is available from the 3 applications presented above.  

 
Figure. V.4. Presentation of ArcToolbox interface. 

[https://desktop.arcgis.com/fr/arcmap/latest/extensions/arcglobe/the-arcglobe-user-interface.htm] 

 

The ArcToolbox allows: 

 File format conversions. 

 Definition, change of projection. 

 Analysis and geoprocessing. 

 Tools specific to ArcGIS extensions. 

 Tools, processing templates created by the user. 

 Processing model (sequence of several tasks). 

 Standard Script tool (Python, VBscript, Javascript...) 
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V.4 Exploring geographic data in ArcCatalog 

Open ArcCatalog: Start > All Programs > ArcGIS > ArcCatalog. 

 

Figure.V.5. Open ArcCatalog on Windows. 

The ArcCatalog interface is organized as follows (see Figure. V.6.) : 

 

Figure.V.6. The ArcCatalog interface. 

First, we create a link to our working directory to quickly access our data geographic : 

Click on the icon  and then navigate to the directory: "D:\ File path” containing the data 

you will work with in your ptoject. 

V.4.1 Menu bar :  

Allowing various operations. 
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V.4.2   Exploration window   

Exploration window on ArcCatalog allows exploring, i.e., browse, copy, paste, move, rename, 

the geographical data. In addition, this window allows to perform ArcGIS-specific data 

management operations, including the creation and organization of new geographic files.  

V.4.3 Visualizatio window   

Visualizatio window allows viewing the geographical data, made up of 3 tabs:  

 Content tab : provides information on the content of the directory, or the name and 

type of file selected in the exploration window. 

 

 Preview tab : allows viewing of the content of the selected file. The drop-down menu 

at the bottom left of this window gives you the choice between the geographical 

representation of the file (“Geography”) or the data table associated with it (“Table”). 

 

 Metadata tab : allows you to view the metadata (data describing the data).  

V.4.4 Tool bars  

Allowing various operations including starting ArcMap and ArcToolbox via the buttons 

, and tools for viewing your data .  

V.5 Types of geographic data  

Each type of data recognized by ArcCatalog is indicated by a specific icon. Figure. V.7. lists 

the most common file types.  

A precise definition of the different file formats used in ArcGIS is available in the ArcGIS 

help via the main menu “Help > ArcGIS Desktop Help >…”:  

• “… > Contents > ArcGIS Glossary > and type the name of the format”  

• “… > Index > Shapefile > described” for example. 
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Figure.V.7. The ArcGIS data icons. 

 

V.6 Handling geographic data files in ArcCatalog 

Geographic data files appearing in ArcCatalog corresponds to several files (see Figure. V.8. 

Table. V.1.). These files are complementary and each contain part of the geographic 

information necessary for correct reading of the corresponding file by ArcGIS. 

 

 

Figure.V.8. ArcCatalog data file types. 
[https://slideplayer.com/slide/6114131/] 
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File extension File description (content) 

.dbf 
Attribute information (Tabular 

Data) 

.shp Feature geometry (Shape File) 

.shx Feature geometry index 

.aih Attribute index 

.ain Attribute index 

.prj Coordinate system information 

.sbn Spatial index file 

.sbx Spatial index file 

.mdb Geodatabase 

.mxd Arc Map Project File 

 

Table. V.1. Geographic data files in ArcCatalog and their descriptions. 

V.6.1 Shape file 

The shapefile (.shp) allows storing geographic location and associated attribute information, 

i.e., shape, and attributes of geographic features.  A shapefile is stored in a set of related files 

and contains one feature class (see Figure. V.9.). 

 

Figure.V.9. ArcCatalog shape file. 
[https://slideplayer.com/slide/6114131/] 
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V.6.2 Coverage  

A coverage is a complex directory structure that stores vector data, i.e., contains both the 

spatial (location) and attribute (descriptive) data, for geographic features. Coverages use a set 

of feature classes to represent geographic features (see Figure. V.10.). 

 
Figure.V.10. ArcCatalog coverage directory. 

[https://slideplayer.com/slide/6114131/] 

V.6.3 Tabular data 

Tabular data (.dbf) forms the basis of geographic features and enables you to view, query, and 

analyze your data. Tables are composed of rows and columns, and all rows have the same 

columns. In ArcGIS, rows represent records, and columns represent fields. Each field is used 

to store a specific type of data, such as a number, date or text (see Figure. V.11.). 

 

Figure.V.11. ArcCatalog tabular data file. 
[https://desktop.arcgis.com/fr/arcmap/latest/manage-data/tables/what-are-tables-and-attribute-information.htm] 
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V.6.4 Map document  

 

Figure.V.12. ArcCatalog Map document properties. 
[https://desktop.arcgis.com/fr/arcmap/latest/manage-data/tables/what-are-tables-and-attribute-information.htm] 

ArcMap document files (.mxd : Map Exchange Document) contain map, specifics about the 

GIS data used (including pointers to the file location for each dataset), display information 

(symbology and labeling) and other elements used in ArcMap. The MapDocument object 

provides access to most of the map document properties (File > Map Document Properties) 

(see Figure. V.12.).  

V.6.5 Geodatabase 

A geodatabase is an efficient way to store GIS information, i.e., spatial and attribute data and 

the relationships that exist among them, in one large file. Conversly to shapefiles that contain 

only one layer, a geodatabase contains many layers, know as « feature classes » (see Figure. 

V.13.). 

 

Figure.V.13. ArcCatalog Geodatabase. 
[https://slideplayer.com/slide/6114131/] 



Chapter V.                                                                                                                     ArcGIS Software 

89 
 

There are three types of geodatabase: 

 File Geodatabases : Stored as folders in a file system. Each dataset is held as a file 

that can scale up to 1 TB in size. This option is recommended over personal 

geodatabases. 

 Personal Geodatabases : All datasets are stored within a Microsoft Access data file, 

which is limited in size to 2 GB. 

 ArcSDE Geodatabases : Stored in a relational database. 

V.6.6 Feature classes 

Feature classes represent homogeneous sets of common features with the same spatial 

representation (such as points, lines, or polygons) and a common set of attributes (see Figure. 

V.14.). The four most commonly used feature classes are points, lines, polygons, and 

annotation (see Figure. V.15.). 

 

Figure.V.14. ArcCatalog feature classes. 
[https://slideplayer.com/slide/6114131/] 

 

Figure.V.15. ArcCatalog Feature entity classes. 
[https://pro.arcgis.com/fr/pro-app/latest/help/data/feature-classes/feature-classes.htm] 

V.6.7 Feature dataset 

Feature dataset is a thematic grouping of feature classes (see Figure. V.16.). 
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Figure.V.16. ArcCatalog Feature dataset. 
 [https://slideplayer.com/slide/6114131/]  

 

V.7 Data management 

You can create new feature classes, tables or relationship classes within a geodatabase (see 

Figure. V.17.). 

 

Figure.V.17. ArcCatalog : Data management : creation of classes. 

 [https://slideplayer.com/slide/6114131/] 

You can import existing shapefiles or coverages into a geodatabse or export a feature class to 

a shapefile (see Figure. V.18.). 
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Figure.V.18. ArcCatalog : Data management : import/export of classes. 

 [https://slideplayer.com/slide/6114131/] 

V.8 Help in ArcCatalog  

In addition to the “Help Tool” presented previously, the “Help” tab, and in particular the 

"ArcGIS Desktop Help" menu of ArcCatalog and ArcMap contains a whole series very well 

documented information to help the user, including (see Figure. V.19.): 

 A search for help via a summary (books), an index or a search menu 

 A glossary of terms used in ArcGIS (“GIS glossary”) 

 Tutorials (in the “Getting started > tutorials” directory) 

 … 

 

Figure.V.19. The ArcGIS help menu. 
[https://vector.geospatial.science/textbook/section-seven-arcgis-help-menu] 

V.9 Open an ArcMap project 

To open an ArcMap project (new or pre-existing), we have two options (see Figure. V.20.): 

a. Click on “Start > All Programs > ArcGIS > ArcMap” 

b. Use the shortcut icon to ArcMap  available in ArcCatalog and choose : 
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 Start using ArcMap with: A new empty map” to open a new empty document 

 Or, “Start using ArcMap with: An existing map” to open a pre-existing 

ArcMap document, and then “Browse for maps”. Then navigate to the pre-

existing ArcMap project in the directory « D:\Project path\Project name.mxd » 

Open the project. 

 

Figure.V.20. The ArcMap : Open ArcMap project. 
[https://desktop.arcgis.com/fr/arcmap/latest/map/working-with-arcmap/starting-arcmap.htm] 

 

V.10 Structure of an ArcMap project 

The ArcMap interface (in « Data View » mode) is organized as follows : 

V.10.1 Table of Contents  

Containing a list of the ArcMap project data layers. The "Table of Contents" subdivides itself 

into three tabs (see Figure. V.21.): 

 Draw order : to select and organize your layers, 

 Source : indicating the directory in which the files are located 

 Selection : containing only the files selected for display. 

 

Figure.V.21. The ArcMap :  Table of Contents. 
[https://slideplayer.com/slide/6114131/] 
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V.10.2 Visualization window  

The ArcMap viewing window displays the geographical data selected in the table of contents 

as an overlay of layers on top of each other according to the order defined in the table of 

contents (the first layer of the table of contents will be displayed above the others in the 

viewing window) (see Figure. V.22.). 

 

Figure.V.22. The ArcMap :  Visualization window. 
[https://desktop.arcgis.com/fr/arcmap/10.4/map/main/mapping-and-visualization-in-arcgis-for-desktop.htm] 

 

V.10.3 Menu bar  

A menu including a whole series of functionalities in the form of drop-down menus. 

V.10.4 Toolbars  

Allowing various operations via button. 

V.11 Managing layer visibility and selections 

V.11.1 Managing layer selection 

To display / not display a layer, simply check / uncheck the box located at left of the layer 

name. Note that it is possible to (un)check everything by pressing on "CTRL" by 

(un)checking a single box (see Figure. V.23.). 



Chapter V.                                                                                                                     ArcGIS Software 

94 
 

 

Figure.V.23. The ArcMap :  Layer selection properties. 

V.11.2 Managing layer visibility 

Three mode existed to manage the layer visibily (see Figure. V.24.): 

 List Default visibility 

 List By Drawing Order Visibility 

 List by visibility 

 

Figure.V.24. The ArcMap :  Layer visibility properties. 
[https://www.esri.com/arcgis-blog/products/arcgis-desktop/data-management/managing-layer-visibility-and-selections/] 

V.11.2.1 List Default visibility 

When adding new layers to a map, ArcMap overlays layer types by default in the following 

order: points (above), lines, polygons, raster (below). To change this order, select a layer by 

clicking on its name and move it below or above its original location.  

V.11.2.2 List By Drawing Order Visibility 

Use List By Drawing Order to author the layers, such as specifying layer order and renaming 

the layers.  
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V.11.2.3 List by visibility 

List By Visibility because shows information about the features within the layers. Layers are 

grouped by whether they are shown on the map and are categorized by Visible, Out of Scale 

Range, or Not Visible.  

V.12 Set Data Source. 

To “repair” a “source path” of data (see Figure. V.25.), 

a. Right-click on the name of the layer concerned,  

b. Go to “Data > Repair data source…”. 

c. Then navigate (using the “Look in” tab) to the directory where the 

geographical data corresponding to this layer "Data source path\File 

name.shp » 

d. Click “Add”. 

 

Figure.V.25. The ArcCatalog :  Changing Data Paths in MXD Files. 
[https://www.esri.com/arcgis-blog/products/arcgis-desktop/data-management/managing-layer-visibility-and-selections/] 

 

V.13 Set the visualization scale range of a layer. 

In order to redefine the visualization scale range of a layer (see Figure. V.26.),  

a. Right-click on the name of the layer concerned,  

b. Go to “Properties…” 

c. Choose the “General” tab and look at the “Scale Range” box. 

d. Check “Show layer at all scales”. 

e. Click “OK” 
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Figure.V.26. The ArcCatalog :  visualization scale range of a layer. 
[https://dusk.geo.orst.edu/buffgis/Arc9Labs/Lab2/lab2.html] 

 

V.14 Definition of the environment coordinate system  

V.14.1 Coordinate system for a ArcMap project. 

The first thing to do when creating a new ArcMap project is to set the coordinate system in 

which you want to work. 

As you will be working on a global database expressed in the system “GCS WGS 1984”, use 

this system. 

To do this, 

a. Right-click on the “data block”  in the “Table of contents” 

 

b. Go to “Properties…”. 

 

c. In the “Coordinate System” tab, you will see that there is still no system of coordinates 

defined for this project (“No projection”). 

 

d. Choose “Predifined \Geographic Coordinate Systems \World\WGS 1984” 

Information about this coordinate system is presented in the "Current Coordinate System”. 

e. Then click “OK” and check the name and system of your data block. 

 

V.14.2 Coordinate system for a Map Layer 

a. Right click on the title of your Map Layer in the Table of Contents of 

ArcMap.  Choose Properties at the bottom of the pop up menu. 

b. Click on the Source tab.  
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c. In the Data Source section, there should be a label that says Geographic 

Coordinate System or Projected Coordinate System.  This tells you which 

Coordinate System this map layer uses. 

d. Check all of your other Map Layers to make sure that they are using the same 

Coordinate System.  If not, use the directions below to change the Coordinate 

Systems to match one another. 

 

V.15 Add data. 

Several methods exist to add data to ArcMap project: 

V.15.1 17.1. Add data present on your PC using the “Add data” button 

a. Click on the button  allowing you to add geographical data in ArcMap. 

b. Then click on the button  allowing you to create a new connection (a shortcut) to 

your working directory. Connect to the directory where all your data is located, in this 

case: “D:\Initiation ArcGIS SIG ACE\DATA\” 

c. Click OK Your new working directory appears in the “Catalog” of the “Add Data” 

window. 

d. Then navigate to the directory containing the data you will need for this particular 

project, in this case: "D:\ Initiation ArcGIS SIG ACE\DATA\3 Add Attribute 

Selection \" 

e. Select all of the existing data (*.shp) present in the corresponding directory. 

f. Click “Add”. 

Your data is added to the viewing window. 

V.15.2 17.2. Add XY point data (GPS for example) to from a spreadsheet (Excel 

or Access for example). 

To import point data from a spreadsheet, 

a. Click on the “Tool” drop-down menu in the main menu bar of ArcMap 

b. Select “Add XY Data…”  

c. Navigate to your localized spreadsheet in “D:\Initiation ArcGIS SIG ACE\DATA\3 

Add 

d. Attribute Selection\” and select the table and spreadsheet of interest. 

e. Select the fields in your spreadsheet that correspond to the X and Y coordinates points 

to import. 

f. Specify the coordinate system in which your points are expressed using the 

“Edit…” button. Two possibilities are available : 

 “Select”, to navigate to the coordinate system of your XY points. 
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 “Import”, to import the coordinate system from a file of already existing geographical 

data and having the same system of coordinates as that of your XY points. Navigate to 

the file “countries.shp 

g. Click “OK”. 

V.16 The attribute table 

The "attribute data" of a geographic data file or "Attribute Table" (the .dbf file) are easily 

accessible in ArcMap. These data are used frequently for various operations such as the 

selection of data, the use of a symbology, etc. 

In the attribute table (see Figure. V.27.), 1 row (or a "record") corresponds to 1 entity spatial. 

1 spatial entity can be composed of several polygons or lines or points, spatially distinct. 

 

Figure.V.27. The ArcCatalog :  Attribute table basics. 
[https://vector.geospatial.science/ArcMap_Data_View/attribute_tables] 

 

V.16.1 Access to the attribute table. 

You have two options for accessing attribute data in ArcMap: 

a. Opening the “Attribute Table” 

b. Identification tool  
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V.16.2 Opening the attribute table. 

a. Right-click on the name of the layer whose attribute table you want to view 

b. Click “Open Attributes Table” 

The layer's attribute table opens. 

V.16.3  The identification tool. 

a. Click on the identification tool  on the “Tools” toolbar 

b. Then click on the spatial entity for which you wish to access the information of the 

attribute table. 

c. An identification window for this spatial entity appears and presents all the 

information from the attribute table of this entity (corresponding to a row of the 

attribute table and all columns/attributes of the table). 

 

V.17 Select data 

In order to work on a reduced set of data and to see more clearly in your interface it can be 

useful to select some spatial entities of interest to be able to export them as a separate file. 

V.17.1 Simple selection. 

The easiest selection method is to manually select features spatial. This type of selection can 

be done in 2 ways, 

a. In the viewing window with the selection tool  (“Select Features Tool”) from the 

“Tools” toolbar. 

 Click on the selection tool 

 Click on the entity(ies) to select 

 A right-click gives you the possibility to carry out the following operations on the 

entity(ies) selected: 

 

 

 

 

b. In the attribute table, 

 Click on the small gray square at the far left of each row to select the entity 

corresponding to this line 
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 The "Options" button of the attribute table gives you the possibility of carrying out the 

following operations on the selected entity(ies): 

 

 

 

In order to facilitate a search in the attribute table before a simple selection, you can carry out 

an ascending or descending classification of your data according to a field particular, via the 

buttons  available by right-clicking on a header of attribute table field. 

In addition to these simple selection methods, ArcMap makes it possible to carry out queries 

of search / selection of entities on a spatial and attribute basis (following section). 

V.17.2 Selection by Attribute. 

Selection by attributes makes it possible to select one or more spatial entities on the basis of 

their attributes using an SQL-like query. 

a. Click on “Selection > Select By Attributes…” in the main menu bar of ArcMap 

b. Choose from the “Layer:” drop-down menu the layer in which you want create a new 

selection, in this case, “Populated_places_PAKISTAN”. 

c. Choose from the “Method:” drop-down menu the method of selection, in this in this 

case “Create a new selection”, to create a new selection. 

d. Then double-click on the [Place_type] field header in the first box White. 

[Place_type] must appear in the lower white box (“SELECT * FROM 

Populated_places_PAKISTAN WHERE:”) where your SQL query is written as you write 

it. 

e. Single-click the “=” button, 

f. Click on the “Get Unique Values” tab showing all the values existing for the field 

selected in the first white box, here [Place_type] 

g. Double-click on "'earth'" in the white box where the types of main constructions in the 

villages. 

Your SQL query should be the same as "[Place_type] = 'earth'". 

h. Click “OK”. 

In your visualization window, the spatial entities corresponding to your request for selection 

are now selected (outline in light blue by default). To see it, the layer in which you made the 

selection must be made visible by checking it in the table of contents. 

The selection by attribute is also directly available in the attribute table of the vector layers: 

"Right click on the layer name > Open Attribute Table > tab “Options” > Select By 

Attributes” and the select by attribute interface for this layer appears. 
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The “Find and Replace” button  available in the table options attributes 

allows you to search and/or replace a certain value in the table. 

V.17.3 Verify if a selection is correct: 

To verify if a selection by attribute is coorect, we have two ways :   

a. Click on the identification tool then on a few selected entities and check the 

information that appears. 

b. Open the attribute table of the “Populated_places_PAKISTAN” layer (click right on 

the name of the layer "Commons" > Open Attributes Table") and activate the 

"Selected" tab at the bottom of the attribute table to only display in the table of 

attributes that the entities (villages in this case) selected (in light blue by fault). 

V.17.4 Selection by Location 

The selection by location allows to select one / several spatial entities of a layer based on the 

spatial relationship (relative position) of this layer with another layer. 

You are going to select the earthen villages that are located in the maximum area in which 

the flood is likely to have serious consequences on the populations, either, in terms of 

techniques, the earthen villages located in the buffer zone identified by the file 

“Indus_downstream_Tarbela_Dam_10km_buffer.shp” 

a. Click on “Selection > Select By Location…” in the main menu bar of ArcMap 

b. Choose from the “I want to:” drop-down menu, and the method of selection, in this 

c. this case “select features from” 

d. Select the “Populated_places_PAKISTAN_earth” layer in the white box “the 

following layer(s):” 

e. Select "that:" "Intersect" from the following drop-down menu 

f. Select “the features in this layer:” 

g. “Indus_downstream_Tarbela_Dam_10km_buffer” in the next drop-down menu 

h. Click “OK” 

V.17.5 Other features available for selections 

ArcMap offers other features for selecting or acting on a selection. To you to discover them 

via the following paths: 

a. Main menu > Selection 

b. Right click on a layer > Selection 

c. In the attribute table > "Option" menu 
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V.18 Create a file from a selection layer or Export file. 

If you wish to create a new file from the entities you have selected (or simply export data to a 

new file), all you need to do is: 

a. Right-click on the name of the layer whose features you want to export selected 

(or on the layer without selected entities in the case of a simple export of the file), 

b. Choose “Data > Export Data…” 

c. Choose to export selected features (“Selected features”) using the same coordinate 

system as (“Use the same coordinate system as:”) the source data layer (“this 

layer’s data source”) 

d. Then click on the yellow folder to save the new “shapefile” that you will create in 

the directory of your choice using the "Output shapefile or feature class: » box, 

giving it an appropriate name. 

e. Click “Save” 

f. Click “OK”. The export takes a little time. 

g. Answer “Yes” to the question “Do you want to add the exported data to the map 

have a layer? », to add the newly created shapefile in ArcMap. 

Your new file appears in ArcMap. 

h. Delete (in the table of contents: right click on the layer > Remove) or possibly 

deactivate (uncheck) the file from which the new file is taken created in order to 

better visualize the latter in the ArcMap interface (optional). 

V.19 Join and Relationship between 2 tables. 

ArcMap provides 2 methods to associate different tables with each other (attribute table or 

other tables) (see Figure. V.29.): 

a. Join (“Join”): allows you to add, in the attribute table of the file from from 

which you are joining, the fields of another table, based on a field containing 

information common to both tables or on a spatial basis. 

 

b. Relation (“Relates”): establishes a link, based on a field containing information 

common, between two tables but does not add the fields of a table in a other. 

The information of a table is accessible from the associated table. 
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Figure.V.29. Relate vs Join for Attribute Tables in ArcMap. 
[https://gisgeography.com/relate-vs-join-attribute-tables-arcgis/] 

V.19.1 Create a join between 2 tables 

Two types of joins exist in ArcMap: 

a. Joint based on an attribute common to 2 tables 

 

b. Join based on the spatial location of features from 2 files 

The same “row” of “Table_2” can be associated with several “spatial entities different" or 

"different rows of the attribute table" from "Table_1" (Figure 10a). 

In the case of an attribute-based join, only one "row" of "Table_2" can be associated with a 

given "line" of "Table_1". 

In the case of a join on a spatial basis, several "rows" of "Table_2" can be associated with a 

given "line" of "Table_1" via an aggregation of the values of the "Table 2" using a simple 

mathematical formula (sum, average, etc.) (Figure 10b). 

V.19.2 Join based on an attribute common to 2 tables 

The join based on an attribute joins a data table to a layer based on the value of a field present 

in both tables. The field name does not have to be the same, but the data type does (see 

Figure. V.30.). 
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Figure.V.30. Join based on an attribute on ArcMap. 
[https://desktop.arcgis.com/fr/arcmap/10.3/tools/data-management-toolbox/add-join.htm] 

To establish a join based on an attribute common to 2 tables (Figure 11), 

1. (Close “Table_1” if it was open) 

2. Right-click on the name of the layer (“Table_1”) to which you want to join the data 

from another table (“Table_2”) 

3. Choose “Joins and Relates > Join…” 

4. Select “Join attributes from a table” in the box “What do you want to join to this 

layer? » 

 Choose the field from “Table_1” on which to base the joint 

 Choose the table to join to this layer (“Table_2”) 

 Choose the field of "Table_2" on which you want to base the joint 

5. Click “OK” 

To view your join, open the attribute table of "Table_1" or of the file exported from the table 

containing the join. You notice that the fields of the "Table_2" was joined to "Table_1". 

To cancel a join, right-click on the name of your layer and go to "Join and Relates > Remove 

Join(s) >” and select the joint to remove. 

To save your join in a new file, right-click on the name of your layer and go to “Data > 

Export Data…”… 

V.19.3 Join based on feature location of 2 files 

The spatial join combines the attributs of features in two layers (tables) based on on location 

or proximity, i.e., one feature closest on thtoe another or one feature inside another (see 

Figure. V.31.). 
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Figure.V.31. Spatial Join based on distance : which airport is closest to the city. 
[https://desktop.arcgis.com/fr/arcmap/10.3/tools/data-management-toolbox/add-join.htm] 

To establish a joint based on the location of the entities of 2 files 

1. Right-click on the name of the layer (“Table_1”) to which you 

want to join the data from another table (“Table_2”) 

2. Choose “Joins and Relates > Join…” 

3. Select “Join data from another layer based on spatial location” 

in the box “What do you want to join to this layer? » 

 Choose the "Table_2" layer to join to the "Table_1" layer Point 2 of the menu 

tells you what type of join you are making (in the case of the “Mali” exercise: 

“Points to Points”). 

 Choose the type of spatial join you want to perform (in the case of the “Mali” 

exercise: the second option) 

 Choose the directory and name of the layer you are creating by performing this 

spatial join. (in the case of the “Mali” exercise: 

“Puits_villages_spatial_join.shp” in the folder "D:\Initiation ArcGIS SIG 

ACE\DATA\4 Join Relate Stats Compute in table») 

4. Click “OK” 

The attribute table of the file you just created contains the initial fields of the "Table_1" and 

the joined fields of "Table_2". Depending on the method you choose, either a "summary" of 

the attributes of the entities of "Table_2", or the attribute of the entity of the "Table_2" closest 

to the entity of "Table_1" will be attached to the attributes of the "Table_1". 

V.20 Create a relationship between 2 tables 

To create a relationship between two tables, 

Right-click on the name of the layer (“Table_1”) to which you wish to link the data from 

another table (“Table_2”) 
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1. Choose “Join and Relate > Relate…” 

2. Choose the field of "Table_1" on which you want to base the link 

 Choose the table to link to this layer (“Table_2”) 

 Choose the field of "Table_2" that you want to link to "Table_1" on which you are 

streaming basing the link 

 Name your link, for example “Relate 1”. 

3. Click “OK” 

You can access this relationship in 2 different ways: 

 Access a relation by the attribute table 

1. Open the attribute table of layer "l" 

2. Select a spatial entity / line 

3. Go to “Options > Related Tables > Relate1: Table 2” 

“Table 2” opens with the related spatial features/lines selected. 

 Access a relationship using the identification tool  

1. Click with the identification  tool on an entity of "Layer 1" 

2. Click on the “+” signs in front of the name of the selected recording to access the 

related table information corresponding to this entity. 

V.21 Calculate statistics in the attribute table 

Two methods allow you to obtain statistics on an attribute table. 

V.21.1 The “Summarize” tool 

The “Summarize” tool creates a new table containing a single row for each value unique of 

the selected field, and calculates the statistics for the other fields. 

1. Right-click on the header of a field in the attribute table of the file of interest 

2. (Well_villages_spatial_join.shp) 

3. Click on “Summarize…” 

 Choose the field to “summarize” (village) 

 Choose the field(s) for which you want to calculate statistics (daily quantity of water 

from wells, i.e. the column “Well_water”) and choose the type of statistics (Sum) 

 Name and save your statistics table in the directory of your choice, 

“Somme_eau_par_village.dbf” in the folder “…\4 Join Relate Stats Compute in table» 

4. Click “OK” 

Answer “Yes” to the question “Do you want to add the result table in the map? » to add this 

table to your table of contents, visible in "Source" mode only (“Source” tab of the table of 

contents) because there is no source file forms associated with this table. 
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V.21.2 The “Statistics” tool. 

The “Statistics” tool is used to calculate the main statistics (Total number, max, min, Sum, 

Mean, Standard Deviation), as well as a graph of the distribution of the frequency of values of 

a selected field. 

1. Right-click on the header of a field in the attribute table 

2. Click on “Statistics…” 
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Appendix  
Glossary Terms used in GIS and Spatial Data Development and Analysis  

Active remote sensing system: A system that both emits energy and records the energy 

returned by target objects.  

ArcGIS: A GIS software package produced by Environmental Research Systems. 

Atmospheric distortion: Image displacement due to the bending of light as it passes through 

the atmosphere.  

Attribute: Non-spatial data associated with a spatial feature.  

Geospatial: A suite of GIS software systems. 

AVHRR: Advanced Very High Resoluton Radiometer.  

Binary classification: A classification of spatial objects into two classes, typically denoted by 

a 0 class and a 1 class.  

Bit: A binary digit.  

Byte: A unit of computer storage consisting of 8 binary digits. A byte may store up to 256 

different values.  

Cartesian coordinate system: A right-angle two or three-dimensional coordinate system.  

Cartographic modeling: The combination of spatial data layers through the application of 

spatial operations. 

Cartographic object: A digital representation of a real-world entity.  

Classification: A categorization of spatial objects based on their properties.  

Coordinates: A pair or triplet of numbers used to define a position in space.  

Data model: A method of representing spatial and aspatial components of real-world entities 

on a computer.  

Database management system (DBMS): A collection of software tools for the entry, 

organization, storage, and output of data.  

DEM: Digital Elevation Model, a raster set of elevations. 

Electromagnetic spectrum: A range of energy wavelengths. 

Entity: A real world item or phenomenon that is represented in a GIS system or database.  

ERDAS: A GIS and remote sensing image processing software package. 

ETM+: Enhanced Thematic Mapper.  

Feature: An object or phenomenon in the landscape. 
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High-pass filter: A raster operation that identifies large or high-frequency differences 

between cells.  

Ikonos: A high resolution imaging satellite system.  

Items: Variables or attributes in a data table  

Idrisi: A GIS system. 

Infrared image: An image that records reflectance in the near infrared wavelengths. 

JPEG: An image compression format.  

Latitude: Spherical coordinates of Earth location that vary in a north-south direction. 

Lidar: Laser detecting and ranging. 

Local operation: A spatial operation where the output location, area, or extent comes from 

operations on that same extent.  

MapInfo: GIS software package produced by MapInfo.  

Map projection: A systematic rendering of features from a spheroid or ellipsoid representing 

the 3- dimensional Earth to a map surface. 

MSS: Multi-spectral Scanner. 

MODIS: Moderate Resolution Imaging Sensor. 

NOAA: National Oceanic and Atmospheric Administration. 

Polygon: A closed, connected set of lines that define an area.  

Polygon inclusion: An area different in some characteristic from the recorded attributes of the 

polygon, but not resol 

Raster data model: A regular “grid cell” approach to defining space.  

Registration: The conversion or assignment of coordinates from a non-projected coordinate 

system to a coordinate system, typically via an affine transformation.  

Slope: The change in elevation over a change in location. 

Spatial operation: A logical, mathematical, selection, or other spatial process that transforms 

spatial data.  

Spectrum: see electromagnetic spectrum 

SPOT: Systeme Pour l’Observation de la Terre. 

TIFF: Tagged Image File Format. 

TM: Thematic Mapper. 

USGS: United States Geological Survey - the U.S. government agency responsible for most 

civilian nationwide mapping and spatial data development.  
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UTM: Universal Transverse Mercator coordinate system. 

Vector data model: A representation of spatial data based on coordinate location storage for 

shapedefining points and associated attribute information. 

Wavelength: The distance between peak energy values in an electromagnetic wave. 


